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RESUMEN 
La presente investigación consiste en el análisis espacio temporal de uso/cobertura y 
NDVI de la cuenca hidrográfica del río Tamulasco, ubicada en el departamento de 
Chalatenango, al norte de El Salvador, a través del programa ERDAS para tratamiento 
de imágenes digitales de satélites. 
 
Las imágenes fueron obtenidas en el año 2003 y el año 2014 por medio del satélite 
IKONOS y una imagen del vuelo LIDAR. Para llevar a cabo el análisis se combinó el 
procesamiento digital de imágenes satelitales, sistemas de información geográfica y el 
análisis espacio temporal.  
 
En los anexos el lector puede encontrar una detallada serie de pasos a seguir para realizar 
pre-procesamiento y procesamiento de imágenes en el programa ya antes mencionado, 
el cual se fundamenta en la elaboración de algoritmos de discriminación de las áreas de 
uso/cobertura.  
 
Cabe recalcar que el enfoque de este trabajo se basa en la discriminación y la clasificación 
de categorías de zonas por medio de firmas espectrales y el concepto de detección de 
cambios por medio del análisis espacio temporal realizado para ambas imágenes.  
 
 

Atentamente 
Jonathan Arévalo 

 
Palabras clave: 
Espacio Temporal 
Teledetección 
NDVIA 
Río Tamulasco 
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INTRODUCCIÓN 
 

La presente investigación consiste en una caracterización espacio-temporal del 
uso/cobertura de la subcuenca hidrográfica Tamulasco ubicada al sur del Departamento 
de Chalatenango, municipio de Las Vueltas; limítrofe al Oeste con Embalse Cerrón 
Grande, la cual se ha delimitado como zona de estudio. 
 
La subcuenca hidrográfica Tamulasco, pertenece a la Región hidrográfica Lempa (Región 
A), los ríos para esta sub cuenca son: Tamulasco, Guarjila y Muca; con quebradas: El Juté, 
Seca; El Cimarrón, La Quebradona, La Junta y El Rosario. 
 
En la subcuenca del río Tamulasco es evidente el deterioro de los suelos por la fisiografía, 
escasa vegetación y aplicación de agroquímicos sin los criterios técnicos adecuados a las 
necesidades del suelo. El río Tamulasco es la fuente principal de abastecimiento de agua 
potable para más de 20 mil habitantes del municipio de Chalatenango. El volumen diario 
extraído del rio es de 𝟖𝟖,𝟐𝟐𝟐𝟐𝟐𝟐 𝒎𝒎𝟑𝟑  de agua (ver: Fichas y proyectos del Río Tamulasco), el 
recurso se ve amenazado principalmente por las malas prácticas agropecuarias que 
disminuyen sustancialmente las posibilidades de infiltración de agua e incrementa la 
erosión de los suelos en la zona de recarga.  
 
Los principales alcances de la investigación, están basados en la elaboración del Mapa 
Uso/Cobertura temporal de dicha zona y en un perfil de distribución espacial, que 
permita identificar la interacción que tiene la subcuenca con las actividades de uso de la 
zona. 
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OBJETIVOS 
 

OBJETIVO GENERAL 
 

Analizar la distribución espacio-temporal de uso/cobertura, a partir de imágenes 
satelitales de la cuenca del río Tamulasco, departamento de Chalatenango. 
 

OBJETIVOS ESPECÍFICOS 
 

Los objetivos específicos del proyecto son: 
 

• Estimar los cambios de uso/cobertura del suelo en la cuenca en cuanto a su 
distribución espacial en un periodo temporal. 
 

• Presentación y resultados de la herramienta para el levantamiento de la información 
de uso/cobertura del suelo basado en la distribución espacio-temporal de la cuenca.   
 

• Combinar con las imágenes de alta resolución de alta resolución del vuelo LIDAR del 
Ministerio del Medio Ambiente y Recursos Naturales de El Salvador. 
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ANTECEDENTES 
 

La necesidad entre las funciones básicas del planeta y el estrecho vínculo de 
aprovechamiento humano por recursos no debe realizarse por separado, por lo que un 
entendimiento y manejo sostenible de los ambientes son indispensables para el desarrollo 
humano y preservación de los recursos naturales. El Salvador cuenta con limitados 
recursos para realizar estudios de teledetección basados en imágenes de satélite, sin 
embargo, se cuenta con esfuerzos realizados por instituciones como el Ministerio del 
Medio Ambiente y Recursos Naturales (MARN) o el Centro Nacional de Registros (CNR) 
a través del Instituto Geográfico Nacional (IGN) para realizar investigaciones científicas 
en diferentes temáticas de interés, así como la implementación de mecanismos para 
reducir los impactos adversos del cambio climático y en la diversidad natural, a través de 
una restauración del paisaje a gran escala, la cual permitirá recuperar los recursos 
ecosistémicos clave, y, además, obtener beneficios de mitigación. 
 
En la región hidrográfica “A” (Figura 1) correspondiente a la cuenca del río Lempa se 
encuentra el Embalse del Cerrón Grande que fue construido en el año 1973, para servir 
de reservorio a la Central Hidroeléctrica del Cerrón Grande, actualmente está 
identificado como uno de los cuerpos de agua más contaminados de El Salvador. 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 1: Mapa general de regiones hidrográficas de El Salvador [SNET/MARN]. 

El municipio de Chalatenango es parte de las municipalidades ribereñas al embalse, se 
abastece por captación de agua en la parte alta del río Tamulasco, administrada por la 
Administración Nacional de Acueductos y Alcantarillados (ANDA), el agua obtenida se 
utiliza principalmente para la zona urbana de la ciudad de Chalatenango. 
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1. MARCO TEÓRICO 
Dentro del marco teórico a continuación, se describirá el ámbito conceptual que se utilizó 
durante el desarrollo de la investigación y las definiciones más relevantes dentro del 
campo. 
 
1.1. CONCEPTOS Y FUNDAMENTOS DE TELEDETECCÍON 
 
La Teledetección es el procedimiento, que consiste en recoger datos desde un punto 
situado a gran distancia del lugar muestreado. Existen dos modos básicos de 
teledetección, diferenciados entre sí simplemente por la distancia desde la que se toman 
las imágenes y, por lo tanto, por el tipo de aparato que las obtiene: por una parte, tenemos 
la fotografía aérea, y por otra la teledetección por satélite.  
 
Jorge Lira (1995), explica la percepción remota haciendo referencia al sistema visual 
humano. En principio, la vista humana funciona a partir de una fuente de iluminación (la 
luz emitida por el Sol, una lámpara), el objeto observado (todo lo que se encuentra dentro 
del paisaje), el cual refleja la luz emitida por la fuente de iluminación, y el sensor remoto 
(ojo humano) con el que se captura dicha luz reflejada, y finalmente la información 
captada es analizada por el sistema de procesamiento humano (cerebro), produciendo 
información valiosa en relación al paisaje (lo que se observa), la que es útil en la toma 
eventual de decisiones sobre el medio ambiente, y el apoyo de campo, que consiste en la 
inspección directa, en varios puntos selectos de la escena, de diferentes atributos de los 
objetos que se encuentran en el terreno, con el fin de evaluar los datos obtenidos 
previamente a distancia. Por su parte Emilio Chuvieco (2002), habla de que la percepción 
remota no solo engloba los procesos para la adquisición información de la superficie 
terrestre a distancia, sino también el posterior procesamiento, en el contexto de una 
determinada aplicación. 
 
Otra definición de percepción remota, abarca el reconocimiento o evaluación de objetos 
por medio de sensores a distancia (Franklin, 2001). El mismo autor menciona que esta 
definición sugiere que el aporte más importante de la teledetección, es la conversión de 
la información recolectada a productos de información, por lo tanto, el verdadero valor 
y desafío de la percepción remota será realizado durante la interpretación de la 
información y la subsiguiente aplicación. Con lo anterior se puede concluir que la 
teledetección es el registro de información captada a distancia a través de un sistema de 
observación (fuente de energía, cuerpo observado, sensor), para su procesamiento, 
evaluación y análisis de información para la interpretación y creación de nueva 
información, la cual servirá en el apoyo de tomas de decisiones. 



 
 

 

2 
 

 
Se utilizan diferentes tipos de fotografía aérea, una primera clasificación es según el tipo 
de película empleada. Según esto, la fotografía aérea puede ser:  
 
• En blanco y negro. Tienen mayor sensibilidad a la luz que el propio ojo, por lo que 

permiten distinguir detalles no apreciables a simple vista.  
 

• En color: gracias a su mayor capacidad para diferenciar tipos de materiales se usan 
en estudios de vegetación, de aguas y cauces y para diferenciar tipos litológicos. 
 

• Infrarrojas en blanco y negro: para distinguir especies vegetales dentro de bosques 
y en estudios de acuíferos y corrientes de agua. 
 

• En falso color: igual que las infrarrojas en blanco y negro, pero se modifica 
artificialmente su escala de grises. 

 
Las fotografías aéreas pueden tomarse con el eje óptico de la cámara vertical 
(ortofotografías) o inclinado. 
 
Para comprender los conceptos más básicos de la teledetección podemos utilizar como 
modelo la fotografía, en particular la digital. Para realizar una fotografía, una cámara 
debe recibir luz. Esta luz procede, en última instancia, del Sol, desde donde llega a los 
objetos como luz blanca. Una parte de esa luz es absorbida por los objetos, mientras que 
el resto se refleja, dando lugar a su color. Un cuerpo que refleja toda la luz que recibe es, 
por lo tanto, blanco, mientras que si la absorbe toda es negro. La luz reflejada por los 
cuerpos llega a la cámara. Ésta dispone de un sistema que descompone la luz en “bandas”, 
una roja, otra azul y una tercera verde, y de un gran número de sensores que reciben esa 
información y la almacenan en una matriz, como si fueran los ojos compuestos de los 
insectos. Cada posición de la matriz es un píxel, y contiene información de la intensidad 
de radiación total, así como de sus componentes en las tres bandas (imagen RGB). Cuanto 
mayor sea el número de sensores (megapíxeles), mayor es la resolución de la imagen, es 
decir, el grado de detalle. O, lo que es lo mismo, la imagen consta de un mayor número 
de puntos, cada uno de ellos de un tamaño menor. 
 
• Foco emisor de radiación, que puede ser el Sol o el propio receptor. Esto establece la 

diferencia entre los dos grandes tipos de teledetección: la pasiva, en la que el satélite 
se limita a recibir la radiación electromagnética emitida por el Sol, y la activa, en la 
que el satélite actúa también como emisor. 
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• Procesos de interacción entre la luz y los objetos: absorción y reflexión. La luz 

disponible para la teledetección es, en principio, la reflejada por el cuerpo. Sin 
embargo, los cuerpos no retienen indefinidamente la energía que absorben, sino que 
vuelven a emitirla, aunque con diferente longitud de onda, lo que permite 
diferenciarla de la radiación reflejada: mientras la radiación reflejada posee una 
longitud de onda entre 300 𝑛𝑛𝑛𝑛 y 3000 𝑛𝑛𝑛𝑛 (ultravioleta, visible e infrarrojo próximo), 
la emitida tiene una longitud de onda entre 7000 𝑛𝑛𝑛𝑛 y 18000 𝑛𝑛𝑛𝑛. Esta región del 
espectro electromagnético se denomina infrarrojo térmico, y guarda relación con la 
temperatura del cuerpo emisor (ley de Stefan-Boltzmann), por lo que la emisividad 
es utilizada por los satélites de teledetección para calcular la temperatura. Los 
diferentes tipos de “cobertura” superficial tienen propiedades características, es decir, 
absorben y reflejan bandas específicas del espectro, lo que permite su identificación 
y, en algunos casos, conocimientos más detallados. Es lo que se denomina “firma 
espectral”. 
 

• Interacción entre luz y atmósfera: la luz reflejada o emitida por la superficie debe 
atravesar la atmósfera hasta alcanzar el sensor. Esto significa que los gases que la 
forman también absorben parte de esa radiación, como si se tratara de un filtro, de 
modo que el satélite solo recibe radiación en determinadas bandas del espectro 
(ventanas de observación). 
 

• El satélite que recibe la radiación es sensible a una o varias bandas del espectro, que 
pueden corresponder al infrarrojo, al visible, al ultravioleta o a las microondas. 
 

• Poder de resolución: es la característica básica de un sensor. Se trata de la capacidad 
para distinguir entre dos datos “contiguos”. Este poder de resolución puede referirse 
a distintos aspectos (Según: Articulo de teledetección, Ministerio de Educación 
Cultura y deporte, España):  

1. Espectral: se refiere a las bandas de longitud de onda que pueden ser captadas por 
el sensor. Un sensor capaz de captar toda la luz visible, por ejemplo, tendrá mayor 
resolución espectral que otro que solo capte la luz verde. 
 

2. Espacial: tiene que ver con el tamaño de la superficie representada por cada píxel. 
Depende de la altura a la que esté el satélite, de su velocidad y del número de 
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detectores. En algunos casos alcanza los 6 metros, es decir, los puntos que en la 
superficie están separados por menos de esos 6 metros aparecen como un único 
punto en la imagen. 
 

3. Temporal: número de horas o días que pasan entre dos observaciones consecutivas 
de la misma zona de la superficie terrestre. 
 

4. Radiométrica: mínima variación en la cantidad de energía que puede ser 
distinguida por el sensor. 
 

5. Los datos recibidos por el satélite son almacenados en una matriz numérica, cada 
una de cuyas posiciones corresponde a un píxel. El valor numérico almacenado en 
cada píxel indica la intensidad de radiación. 

 
• Correcciones: los datos obtenidos deben ser corregidos para que resulten de utilidad. 

Como mínimo, deben aplicarse dos tratamientos:  

1. Georeferenciación, es decir, relacionar la imagen conseguida con una referencia 
espacial, de modo que se identifique la zona a la que corresponde. 

 
2. Corrección atmosférica para reducir el “ruido” debido a la dispersión provocada 

por la difusión atmosférica de la radiación. 
 
• Tratamiento de la imagen: en general, las imágenes obtenidas son en blanco y negro 

y corresponden a bandas estrechas del espectro (por ejemplo, en el rojo, en el verde 
o en el azul). Para facilitar la interpretación de las imágenes pueden someterse a 
diferentes tratamientos matemáticos, tales como: 
 

1. Obtención de imágenes en color, combinando varias imágenes en blanco y negro. 
Si se parte de imágenes en rojo, verde y azul se pueden conseguir fotografías de 
color real. 

 
2. Obtención de imágenes en falso color: resultan frecuentes las imágenes en las que 

las zonas frías aparecen en tonos azules y las calientes en rojo. Dichas imágenes se 
obtienen a partir de la banda del infrarrojo térmico, transformando los valores de 
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intensidad en colores RGB. Este tipo de tratamiento es habitual cuando los 
sensores detectan radiación fuera del visible. 

 
3. Aplicación de índices espectrales, que permiten identificar los diferentes tipos de 

cobertura superficial gracias a sus “firmas espectrales”. 

Los satélites de teledetección pasiva suelen utilizar bandas correspondientes al infrarrojo, 
visible o ultravioleta, mientras que los de detección activa usan ondas de radar, en la 
región de las microondas (Según: Artículo de teledetección, Ministerio de Educación 
Cultura y deporte, España). 
 
1.2. FUNDAMENTOS FÍSICOS DE LA TELEDETECCIÓN 
 
La radiación electromagnética 
 
Dada la importancia que la radiación electromagnética tiene como transmisor de 
información en todas las formas de teledetección, es necesario hacer un estudio de la 
misma y sus propiedades. La radiación es una de las tres formas de transmisión de 
energía en la naturaleza (conducción, convección y radiación) siendo la única que se 
transmite sin contacto material entre el emisor y el receptor. La energía se expresa en 
Julios (𝐽𝐽), por tanto, la transferencia o flujo de energía se expresa por unidad de área (𝐽𝐽 =
𝑚𝑚2), por unidad de tiempo (𝐽𝐽 = 𝑠𝑠 = 𝑊𝑊) o por unidad de tiempo y área (𝑊𝑊 = 𝑚𝑚2). La 
naturaleza de la radiación electromagnética puede ser explicada a partir de dos modelos 
aparentemente contradictorios y en el fondo, complementarios: el modelo de onda y el 
de partícula (según: Artículo de Fundamentos físicos de la teledetección, Universidad de 
Murcia, España). 
 
Modelo de onda 
 
Desarrollado por Huygens y Maxwell entre otros. Se asume que la radiación se produce 
como resultado de oscilaciones en los campos eléctrico y magnético en las inmediaciones 
de los objetos. Estas oscilaciones generan ondas que contienen 2 campos de fuerzas 
ortogonales entre sí, eléctricas y magnéticas, y transmiten la energía. Al ser ondas pueden 
definirse por una serie de parámetros: 

• Longitud 𝜆𝜆 o distancia entre dos picos de onda (se mide en 𝜇𝜇𝜇𝜇, es decir 10−6 metros). 
• Frecuencia 𝜈𝜈 o tiempo transcurrido entre el paso de dos picos de onda, se mide en 

𝑠𝑠−1 o hercios.  
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El producto de ambos es la velocidad de la luz 𝑐𝑐 =  𝜆𝜆𝜆𝜆 =  3 × 108 𝑚𝑚
𝑠𝑠

 que es constante, por 
tanto si aumenta 𝜆𝜆 debe disminuir 𝜈𝜈 y viceversa. 
 
Modelo de partícula 
 
Desarrollado por Planck y Einstein entre otros. Se asume que la energía viaja como un 
flujo de partículas, los fotones. La energía transportada por cada fotón (Q) depende del 
objeto que emite la radiación. Ambos modelos se relacionan mediante la ecuación: 
 

𝑸𝑸 = 𝒉𝒉𝒉𝒉
𝝀𝝀

   (Ec. 1.1) 

 
Donde h es la constante de Planck (6.626 × 10−34 𝐽𝐽𝐽𝐽). La ecuación implica que a menor 
longitud de onda mayor es la energía transportada por la radiación y, por tanto, más 
peligrosa. 
 
El espectro electromagnético 
 
El conjunto de las longitudes de onda que puede adoptar la radiación se denomina 
espectro electromagnético. Por razones prácticas se suele dividir en una serie de regiones 
debido a que las longitudes de onda dentro de esas regiones presentan cierta 
homogeneidad en determinados aspectos. Los límites de que se han fijado a esas regiones 
son aproximados y varían de unos autores a otros, existiendo además superposiciones 
entre regiones contiguas. 
 
Cada una de estas regiones se divide además en categorías adicionales. La luz visible 
suele dividirse en azul (0.4 − 05 𝜇𝜇), verde (0.5 − 0.6 𝜇𝜇) y rojo (0.6 − 0.7 𝜇𝜇) aunque en la 
realidad se presenta un continuo de colores. La radiación infrarroja se divide en infrarrojo 
próximo (0.7 − 1.3 𝜇𝜇), infrarrojo medio (1.3 −  8 𝜇𝜇) e infrarrojo térmico (8 −  14 𝜇𝜇). El 
primero es aquel en el que la radiación solar tiene más importancia que la terrestre; el 
último aquel en el que la radiación terrestre debida al calor de la Tierra, de ahí el nombre, 
tiene más importancia que la solar; finalmente el infrarrojo térmico corresponde a una 
zona de solapamiento (Figura 1.1). 
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Figura 1.1: Espectro electromagnético y técnicas de teledetección (Kuenzer y Dech, 2013) 

 
1.3. TERMINOLOGÍA Y UNIDADES DE MEDIDAS 
 
Campo radiativo: es el campo electromagnético transportado por las ondas entre el 
emisor y el receptor. La energía asociada con la onda electromagnética se denomina 
energía radiante. 
 
Emisividad (𝝐𝝐): En función de este factor y según las leyes de Planck, Stefan y Wien se 
puede conocer cómo sería la radiación de un cuerpo a una temperatura dada si su 
eficiencia fuera del 100 %. En realidad, este no suele ser el caso, sino que todos los cuerpos 
tienen una emisividad algo inferior a 1. En función de la emisividad, los cuerpos pueden 
dividirse en: 
 
i. Cuerpo negro o radiador perfecto: el que emite radiación al máximo de sus 

posibilidades (𝜖𝜖 = 1). 
 

ii. Cuerpo gris, aquel en el que la emisividad está en el intervalo 0 < 𝜖𝜖 < 1. 
 

iii. Reflector perfecto: 𝜖𝜖 = 0. 
 

iv. Radiador selectivo: 𝜖𝜖𝜆𝜆 = 𝑓𝑓(𝜆𝜆), es decir la emisividad depende de la longitud de onda 
que se considere. 
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Energía radiante (Q), total de energía radiada por un cuerpo en todas direcciones, se 
mide en Julios (𝐽𝐽). 
 
Flujo radiante (𝝓𝝓), es la energía radiante transferida por radiación de una superficie a 
otra por unidad de tiempo, es decir, cantidad de energía que se transmite por segundo 

(algo así como el caudal de energía) 𝜙𝜙 = 𝑄𝑄
𝑡𝑡

 y se mide en 𝐽𝐽𝑠𝑠−1 =  𝑊𝑊. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 1.2: Espectro de emisión aproximado del sol, 6000 K, y de la Tierra, 300 K. También se señalan 
las diferentes regiones del espectro electromagnético. Extraído de (Sanchez and Tancredi). 

 
 
 
 
 
 
 
 
 
 

Figura 1.3: Comparación entre ángulo plano (izquierda) y ángulo sólido (derecha). 
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Intensidad radiante (𝑰𝑰), es el flujo radiante procedente de una fuente de radiación por 

unidad 1de ángulo sólido (Ω) y en una dirección concreta 𝐼𝐼 = 𝜙𝜙
Ω

= Q
𝑡𝑡
∗ Ω, se mide en 𝑊𝑊 

𝑠𝑠𝑟𝑟−1  =  𝐽𝐽𝑠𝑠−1𝑠𝑠𝑟𝑟−1. 
 
Angulo sólido o ángulo cónico (𝛀𝛀), es el ángulo tridimensional formado en el vértice de 
un cono. La unidad del ángulo sólido es el esteroradian (𝑠𝑠𝑠𝑠) y se define como el ángulo 
sólido para el que la superficie 𝐴𝐴 es igual a 𝑟𝑟2 donde 𝑟𝑟 es el radio de la esfera. Puesto que 
el área de una esfera es 4𝜋𝜋𝑟𝑟2 , en una esfera completa hay 4𝜋𝜋  estereorradianes. En la 
Figura 1.3 se muestra ángulo plano (izquierda) con un ángulo sólido (derecha) para 
facilitar la interpretación del concepto. 
 
Emitancia (𝑴𝑴), es la energía emitida por radiación desde una superficie por unidad de 
tiempo y de superficie (cantidad de energía que se transmite cada segundo por cada 
metro cuadrado de la superficie emisora) 𝑀𝑀 = 𝜙𝜙

𝐴𝐴
 = 𝑄𝑄

𝑡𝑡
 ∗ 𝐴𝐴, se mide en 𝐽𝐽𝑠𝑠−1𝑚𝑚−2. A veces 

se habla de la emitancia espectral 𝑴𝑴𝝀𝝀. Para hacer referencia a la emitancia en una longitud 
de onda concreta, en cuyo caso las unidades son: 𝐽𝐽𝑠𝑠−1𝑚𝑚−2𝜇𝜇−1 =  𝑊𝑊𝑚𝑚−2𝜇𝜇−1. 
 
Irradiancia (𝑬𝑬), es la energía que llega a un cuerpo a través del espacio procedente de 
otro que la ha emitido (el concepto es similar al de emitancia). Tiene las mismas unidades 
que la emitancia, análogamente puede hablarse también de irradiancia espectral. 
 
Radiancia (𝑳𝑳), es el flujo radiante 𝜙𝜙 que abandona una unidad de área en una dirección 
particular siguiendo un ángulo sólido particular. Las unidades en que se mide son 
𝑊𝑊𝑚𝑚−2𝑠𝑠𝑟𝑟−1. Su importancia estriba en que es la magnitud que detecta el sensor. Cuando 
la radiancia se refiere a una porción concreta del espectro electromagnético se le 
denomina radiancia espectral (𝐿𝐿𝜆𝜆). 
 

𝑳𝑳 = 𝝓𝝓
𝛀𝛀∙𝐜𝐜𝐜𝐜𝐜𝐜 𝜽𝜽∙𝑨𝑨

     (Ec. 1.2) 

 
Donde 𝜃𝜃 es el ángulo formado por la dirección del flujo radiante y el vector perpendicular 
a la superficie receptora de tamaño A. 
 
Reflectancia o albedo, (𝝆𝝆) es la parte de la irradiancia que refleja la superficie receptora, 
se mide en tantos por uno y se considera por tanto adimensional, es diferente para cada 
superficie receptora y para cada cuerpo. La medida de la reflectancia puede hacerse 
teniendo en cuenta toda la semiesfera superior de una determinada superficie, se habla 
en este caso de reflectividad hemisférica (𝜌𝜌ℎ). 
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Absorbancia (𝜶𝜶), es la parte de la irradiancia que absorbe la superficie receptora, se mide 
en tantos por uno. 
 
Transmitancia (𝝉𝝉), es la parte de la irradiancia que transmite la superficie receptora, se 
mide en tantos por uno. Lógicamente 𝜌𝜌 + 𝛼𝛼 + 𝜏𝜏 = 1. 
 
Los valores de Reflectancia, Absorbancia y Transmitancia son adimensionales y fueron 
introducidos en la Ecuación (Ec. 1.4). Cabe recordar que la suma de los tres debe ser igual 
a uno. 
 
Las radiancias espectrales que son reflejadas desde la superficie terrestre hacia el sensor 
dependen de muchos factores, destacando las variaciones de la irradiancia solar, las 
condiciones atmosféricas y meteorológicas, las propiedades reflectivas de la superficie y 
las condiciones del sensor. (Según: Artículo de Fundamentos físicos de la teledetección, 
Universidad de Murcia, España). 
 
1.4. FOTOGRAMETRÍA 
 
Fotogrametría es definida como la ciencia o arte de realizar mediciones en base a 
fotografías a fin de determinar características métricas y geométricas de los objetos 
fotografiados, como, por ejemplo; tamaño, forma y posición. Mientras que en 
fotogrametría se estudian los aspectos métricos de las fotografías, en fotointerpretación 
se da especial interés al aspecto cualitativo de dichas fotos. Fotointerpretación puede 
definirse como el arte de analizar imágenes fotográficas a fin de identificar elementos por 
reconocimiento y deducción. Es evidente que entre fotogrametría y fotointerpretación no 
existe una separación estricta, sino que por el contrario ambas están íntimamente ligadas 
y no puede hablarse de una sin incluir conceptos de la otra.  Por ejemplo, sería imposible 
medir las dimensiones de un objeto para incluirlo en un mapa sin haberlo previamente 
identificado. 
 
El objetivo principal de la fotogrametría es la confección de mapas topográficos mediante 
el empleo de fotografías aéreas o terrestres y el análisis cuantitativo y cualitativo en la 
imagen.  Sin embargo, la elaboración de mapas no es la única aplicación, ya que por 
métodos fotogramétricos es posible  determinar las coordenadas (X, Y, Z) de puntos de 
control en el terreno (sustituyendo en parte los métodos topográficos convencionales por 
los de triangulación aérea), diseñar carreteras, canales y otras obras de ingeniería civil y 
una serie  de aplicaciones no topográficas como estudio de deformaciones de estructuras, 
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levantamientos de planos de frentes de edificios y monumentos para su conservación y 
restauración, etc. 
 
La palabra Fotogrametría se deriva etimológicamente de las siguientes palabras griegas: 
“photos” que significa luz, “gramma” que significa lo que está dibujado o escrito y 
“metron” que significa medir.  El significado original, derivado de las raíces griegas sería 
entonces – medir gráficamente por medio de luz. Frecuentemente se divide la 
fotogrametría en diferentes especialidades o categorías de acuerdo al tipo de fotografía 
empleada o la forma en que es empleada. Cuando las fotografías son tomadas desde un 
punto de la superficie terrestre (generalmente con el eje horizontal) se habla de 
Fotogrametría terrestre. Si las fotos son tomadas desde un avión, helicóptero o vehículo 
espacial, ya sean fotografías verticales o inclinadas se habla de Fotogrametría aérea. 
 
La Estereofogrametría se refiere al análisis de pares de fotografías me cubren una zona 
común para realizar interpretaciones y medidas en visión estereoscópica, es decir que por 
medio de relaciones matemáticas llamadas formulas básicas de transformación y 
generalmente mediante el empleo de computadores electrónicos se reconstruye el 
modelo pudiéndose calcular las coordenadas espaciales (X, Y, Z)  a partir de las 
coordenadas planas (X, Y). 
 
El mayor campo de aplicación de la fotogrametría es en el área de topografía y 
mapificación y aunque constituye sólo una etapa del proceso del total de mapificación, 
es sin lugar a dudas una de las princípiales, ya que consiste en el levantamiento de los 
detalles del terreno y su control por medio de triangulación espacial. Cuando se toman 
fotografías aéreas de una zona, la imagen obtenida es similar a un mapa, sin embargo, 
desde el punto de vista cartográfico no puede ser considera- do como tal, debido a las 
deformaciones de la imagen. Será necesario conocer exactamente esas deformaciones 
geométricas para eliminarlas o corregirlas por medio de instrumentos y métodos 
especiales, que permitan en definitiva transformar la fotografía aérea en un mapa (Según: 
Grupo de Investigación en Geomática – UIS). 
 
1.5. PROCESAMIENTO DIGITALES DE IMÁGENES 
 
Procesamiento de imagen digital implica la manipulación e interpretación de imágenes 
digitales con la ayuda de un ordenador. Esta forma de la teledetección en realidad 
comenzó en la década de 1960 con un número limitado de investigadores que analizan 
los datos del escáner multiespectral aerotransportado y fotografías aéreas digitalizadas. 
Sin embargo, no fue hasta el lanzamiento del Landsat-1, en 1972, que se hicieron 
ampliamente disponibles para aplicaciones de teledetección terrestres datos de imágenes 
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digitales. En ese momento, no sólo fue la teoría de la matriz y la práctica de procesamiento 
de imágenes digitales en su infancia, sino también el costo de las computadoras digitales 
era muy alto y su eficiencia computacional fue muy baja para los estándares modernos.  
 
Hoy en día, el acceso a bajo costo, hardware eficiente y software es un lugar común, y los 
datos de imagen de fuentes son muchas y variadas. Estas fuentes abarcan desde sistemas 
de satélites de recursos de tierra comerciales, a los satélites meteorológicos, a los datos de 
escáner en el aire, a los datos de las cámaras digitales en el aire, a los datos de imagen 
generados mediante el escaneo microdensitómetro y otros sistemas de digitalización de 
alta resolución. El procesamiento digital de imágenes es un tema muy amplio, y que a 
menudo implica procedimientos que pueden ser matemáticamente complejos. 
  
La idea central detrás de procesamiento digital de imágenes es bastante simple. La 
imagen digital se alimenta a un ordenador de un pixel a la vez. El ordenador está 
programado para insertar estos datos en una ecuación o serie de ecuaciones, y luego 
almacenar los resultados del cálculo para cada píxel. Estos resultados constituyen una 
nueva imagen digital que pueden ser mostradas o grabadas en formato pictórico o 
pueden en sí manipular aún más por programas adicionales. Las posibles formas de 
manipulación de imágenes digitales son literalmente infinitas. Sin embargo, 
prácticamente todos estos procedimientos pueden clasificarse en uno (o más) de los 
siguientes grandes tipos de operaciones asistidas por ordenador (Kuenzer y Dech, 2013): 
 
1. Rectificación y restauración de imágenes.  

Estas operaciones tienen como objetivo corregir los datos de imágenes distorsionadas 
o degradados para crear una representación más fiel de la escena original. 
Normalmente, esto implica el procesamiento inicial de datos de imágenes en bruto 
para corregir las distorsiones geométricas, para calibrar los datos radiométricamente, 
y para eliminar el ruido presente en los datos. Por lo tanto, la naturaleza de cualquier 
proceso de restauración de la imagen, en particular, depende altamente de las 
características del sensor utilizado para adquirir los datos de imagen. La rectificación 
y restauración de la imagen son procedimientos que a menudo se denominan 
operaciones de preprocesamiento, porque normalmente preceden a su posterior 
manipulación y el análisis de los datos de imagen para extraer información específica.  
 

2. Mejora de la imagen.  

Estos procedimientos se aplican a los datos de imagen con el fin de mostrar de 
manera más eficaz o grabar los datos para la interpretación visual subsiguiente. 
Normalmente, la mejora de imagen implica técnicas para aumentar las distinciones 
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visuales entre características en una escena. El objetivo es crear "nuevas" imágenes de 
los datos de imagen originales con el fin de aumentar la cantidad de información que 
puede ser interpretado visualmente a partir de los datos. Las imágenes mejoradas se 
pueden visualizar de forma interactiva en un monitor o que se pueden grabar en un 
formato impreso, ya sea en blanco y negro o en color. No hay reglas simples para la 
producción de la "mejor" de una sola imagen para una aplicación particular. A 
menudo varias mejoras hechas de la misma imagen "cruda" son necesarias. 
 

3. Clasificación de imágenes.  

El objetivo de estas operaciones es reemplazar el análisis visual de los datos de 
imagen con técnicas cuantitativas para la automatización de la identificación de 
características en una escena. Esto normalmente implica el análisis de datos de 
imágenes multiespectrales y la aplicación de reglas de decisiones basadasen 
estadísticas para determinar la identidad de la ocupación del suelo de cada píxel en 
una imagen. Cuando estas reglas de decisión se basan únicamente en las radiancias 
espectrales observadas en los datos, nos referimos al proceso de clasificación como el 
reconocimiento espectral patrón.  
 
En contraste, las reglas de decisión pueden estar basados en las formas geométricas, 
tamaños y patrones presentes en los datos de imagen. Estos procedimientos se 
dividen en el dominio de reconocimiento espacial patrón. En cualquier caso, la 
intención del proceso de clasificación es clasificar todos los píxeles de una imagen 
digital en una de varias clases de cobertura de la tierra, o "temas". Estos datos 
categorizados pueden entonces ser utilizados para producir mapas temáticos de la 
cobertura de la tierra presente en una imagen, y/o producir estadísticas de resumen 
en las áreas cubiertas por cada tipo de cobertura de la tierra. 

 
1.6. RECTIFICACIÓN DE IMAGEN Y RESTAURACIÓN 
 
Como se mencionó anteriormente, la intención de rectificación de imagen y restauración 
es para corregir datos de imagen para distorsiones o degradaciones que se derivan del 
proceso de adquisición de imagen. Obviamente, la naturaleza de estos procedimientos 
varía considerablemente con factores tales como el tipo de adquisición de imagen digital 
(cámara digital, a lo largo de la vía del escáner, a través de la vía del escáner), plataforma 
(satélite vs. en el aire), y en el campo total de visión. Hacemos ningún intento para 
describir toda la gama de rectificación de imágenes y de restauración de los 
procedimientos aplicados a cada uno de estos diferentes tipos de sensores. Por el 
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contrario, en que tratamos a estas operaciones bajo los títulos genéricos de corrección 
geométrica, corrección radiométrica, y la eliminación de ruido (Kuenzer y Dech, 2013). 
 
 
1.7. ¿QUÉ ES «USO DE LA TIERRA»?  

 
Según CUTS (Cambio de uso de la tierra y silvicultura) – El uso de la tierra hace referencia 
al tipo de actividad que se lleva a cabo en un terreno, tales como tierra forestal, de cultivo 
o pastizal. (UTCUTS). 
 
El Grupo Intergubernamental de Expertos sobre el Cambio Climático (IPCC, por sus 
siglas en inglés) ha establecido seis categorías para el uso de la tierra, a saber: tierras 
forestales, tierras agrícolas, pastizales, humedales, asentamientos y otras tierras (tales 
como suelos sin vegetación, rocas, hielo, etc.). (Iversen P., Lee D., y Rocha M.). 
 
1.8. TELEDETECCIÓN O SENSORAMIENTO REMOTO 
 
El sensoramiento remoto implica medir alguna propiedad de un objeto de interés desde 
la distancia. En este marco, el advenimiento de los satélites artificiales ha brindado la 
posibilidad de obtener información detallada de nuestro planeta mediante la cobertura 
de grandes extensiones de territorio y revisitas periódicas. Este hecho significó un avance 
extraordinario para los investigadores enfocados en el seguimiento de cambios espaciales 
y temporales de un abanico amplísimo de problemáticas tales como: caracterización de 
la atmosfera, sistemas hidrológicos, agricultura, usos de suelo, entre otros. La primera 
experiencia fue rusa en 1957 con el lanzamiento de Sputnik 1 que contaba con dos 
transmisores de radio y orbitó la Tierra a una distancia de 938 km. En esa oportunidad, 
el análisis de las señales de radio se usó para obtener información sobre la concentración 
de los electrones en la ionósfera. Estados Unidos no se quedó atrás y en 1959 lanzó al 
espacio el Explorer 6. En un principio y hasta finales de la década del sesenta las misiones 
fueron diseñadas exclusivamente para realizar estudios atmosféricos o relacionados al 
balance radiativo de la Tierra. Recién en 1972 se lanzó el ERTS-1 (LANDSAT- 1), que fue 
el primer satélite construido para la observación en alta resolución de la cubierta terrestre. 
A partir de ese momento, la teledetección se benefició de los avances obtenidos en la 
carrera espacial y alcanzó un nivel muy alto que permitió a los investigadores y 
tomadores de decisiones ir reemplazando la fotografía aérea. 
 
La Figura 1.4 muestra un esquema con los principales eslabones que involucra la 
percepción remota o teledetección y que se detallan a continuación: 
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Figura 1.4: Componentes de un sistema de teledetección pasivo. Adaptado de (Chuvieco). 
 
Fuente de energía: Necesaria para proveer energía electromagnética la superficie bajo 
estudio. 
 
Atmósfera: Se encuentra incluida debido a que se interpone entre el sensor y la superficie 
interaccionando con la radiación de varias formas. 
 
Objeto o Blanco: Es la cubierta terrestre u objeto de estudio. Según sus propiedades la 
interacción electromagnética generará una respuesta característica que medirá el sensor. 
 
Sensor remoto: Es un dispositivo que recoge y graba la radiación electromagnética 
reflejada o emitida por la superficie y la atmósfera. El instrumento se monta en una 
plataforma llamada satélite. 
 
Transmisión, recepción y procesamiento: Estos tres procedimientos garantizan que la 
energía registrada por el sensor se transmita a una estación receptora, en donde los datos 
sean procesados y convertidos en imágenes digitales. 
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Interpretación y análisis: Esta etapa consiste en interpretar la imagen para extraer la 
información pertinente. 
 
Usuario final: Este último eslabón es la razón por la cual se construye todo el sistema, es 
quien le da una aplicación a la información extraída de las imágenes para un mejor 
conocimiento de los objetos de interés. 
 

1.8.1. Plataforma satelital 
 
Las plataformas satelitales son las que sostienen en el espacio a los distintos sensores que 
circundan al globo terrestre. A este itinerario de desplazamiento se le denomina órbita. 
Cuando las plataformas satelitales se encuentran orbitando la Tierra, comienzan a 
recopilar información temática de la cubierta terrestre accesible, en función de las 
características propias del sensor o sensores a bordo de ellas (Chuvieco, 2002). 
 

1.8.2. Tipos de órbita 
 
Existen dos tipos de Orbitas como se puede ver en la Figura 1.5:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 1.5:  
(a): Ejemplo de Satélite geoestacionario de la serie GOES, distancia a la superficie terrestre igual a 36500 
km. En la misma figura, más cerca de la superficie, aparece un satélite de órbita polar. 
  
(b): Modelo de adquisición de imágenes de un sensor a bordo de un satélite con órbita helio sincrónica. 
 
 

(a) (b) 
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1. Órbita Geo sincrónica: Esta es una órbita circular a gran altura, denominada 
geoestacionaria porque se sincroniza al movimiento de rotación terrestre, obteniendo 
buenas resoluciones temporales, pero a costa de baja resolución espacial. 
 
2. Órbita Helio sincrónica: Esta es una órbita elíptica, que aprovecha el movimiento de 
rotación de la Tierra para situarse en el mismo punto cada cierto tiempo con similares 
características para la adquisición de la imagen, tal como se deduce de la Figura 1.5 (b). 
El satélite LANDSAT5, que lleva a bordo el sensor TM (Mapeador Temático, por sus 
siglas en inglés, Thematic Mapper) utilizado en este trabajo de tesis, sigue una órbita de 
este tipo.  
 

1.8.3. Sensor Remoto 
 
El sensor1 remoto es el instrumento que se encuentra en la plataforma satelital capaz de 
captar la energía procedente de la cubierta terrestre. Existen dos tipos de sensores: activos 
y pasivos (Chuvieco). Los primeros poseen una fuente de radiación propia, es decir que 
perturban el objeto al cual se le mide una determinada propiedad y luego recibe y procesa 
la respuesta. Un ejemplo de estos sensores son los radares pertenecientes al programa 
SIASGE (Sistema Italo Argentino de Satélites para la Gestión de Emergencias), del cual 
forma parte la CONAE. 
 
El SIASGE estará integrado por dos satélites SAOCOM provistos por CONAE que se 
lanzarán en los próximos años y cuatro satélites de la constelación italiana Cosmo-
SkyMed de la Agencia Espacial Italiana (ASI) que ya se encuentran en _orbita. Por otro 
lado, los sensores pasivos son aquellos que sólo reciben una señal electromagnética 
producto de la reflexión del sol, la luna o las estrellas sobre la superficie terrestre, pero 
no son capaces de perturbar el sistema al cual se le realiza la medición.  
 
Dependiendo de la forma de recibir la energía procedente de los distintos objetos, los 
sensores remotos se clasifican en:  
 
1. Sensores pasivos, los cuales dependen de la radiación solar para captar la energía 

reflejada o emitida por fuentes naturales. 
 

2. Sensores activos, los cuales generan su propia energía para iluminar los rasgos de 
interés y medir la radiación que regresa a ellos (Hori, 1998). 

                                                 
1 Los sensores son el instrumento con el cual se va registrando la energía reflejada por la superficie terrestre 
y son transportados en plataformas (aviones o satélites) a distancia de la superficie terrestre. 
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La resolución de un sistema sensor, es la habilidad que tiene para registrar información 
a detalle. Chuvieco (Chuvieco, 2002) explica que dicha información no sólo se refiere al 
detalle espacial, sino que existe la resolución espectral radiométrica y temporal, siendo 
estas las más habituales dentro del terreno de la percepción remota. 
 

1.8.4. Resolución del Sensor Remoto 
 
1. Resolución espacial: Este concepto designa el objeto más pequeño que puede ser 

distinguido sobre una imagen, el cual se visualiza en la unidad mínima de 
información denominada píxel. Dado que una imagen es bidimensional, su 
resolución espacial puede ser diferente en el eje 𝑥𝑥 e 𝑦𝑦. 
 

2. Resolución espectral: Indica el número y el ancho de bandas en el espectro 
electromagnético que puede discriminar un sensor. El sensor LANDSAT5-TM se 
considera multiespectral debido a que presenta 7 bandas anchas (por ejemplo, las 
ópticas son de 100 𝑛𝑛𝑛𝑛 de ancho aproximadamente). Una mayor resolución espectral 
en el rango ultravioleta, óptico o infrarrojo, permite obtener mayor información 
química de la superficie observada. 
 
Profundizando en el tema, se puede decir que, de la energía reflejada, el sensor 
registra ciertos rangos de las longitudes de onda. El registro se hace en distintos 
rangos del espectro electro magnético y de acuerdo con Chuvieco, desde el punto de 
vista de la percepción remota se pueden destacar una serie de bandas espectrales que 
son las más frecuentemente empleadas: 
 
• Espectro visible (𝟎𝟎,𝟒𝟒 − 𝟎𝟎,𝟕𝟕 𝝁𝝁𝝁𝝁). Radiación electromagnética que puede percibir 

el ojo humano. En esta región suelen distinguirse tres bandas, por lo general se 
dividen en azul (A, 0,4 − 0,5 𝜇𝜇𝜇𝜇), verde (V, 0,5 − 06 𝜇𝜇𝜇𝜇), y rojo (R, 0,6 − 0,7 𝜇𝜇𝜇𝜇). 
 

• Infrarrojo cercano (IRC, 𝟎𝟎,𝟕𝟕 − 𝟏𝟏,𝟑𝟑 𝝁𝝁𝝁𝝁 ). Utilizado para distinguir masas 
vegetales. 
 

• Infrarrojo medio (𝟏𝟏,𝟑𝟑 − 𝟖𝟖 𝝁𝝁𝝁𝝁). En esta región se registran la reflexión de luz 
solar y emisión de la superficie terrestre. La primera banda se sitúa entre 1,3 y 
2,5 𝜇𝜇𝜇𝜇 y se denomina infrarrojo de onda corta (Short Wave Infrared, SWIR), ideal   
para   detectar   humedad   en   la vegetación o suelos. La segunda banda se 
encuentra cerca de los 3,7 𝜇𝜇𝜇𝜇, se le conoce como el infrarrojo medio (IRM), siendo 
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determinante para la detección de focos de alta temperatura (Volcanes activos, 
incendios forestales). 
 

• Infrarrojo lejano o térmico (IRT, 𝟖𝟖 −  𝟏𝟏𝟏𝟏 𝝁𝝁𝝁𝝁). Incluye la porción emisiva del 
espectro terrestre, en donde se detecta el calor proveniente de la mayor parte de 
las cubiertas terrestres. 
 

• Micro-ondas (M, arriba de 1mm). Es energía prácticamente transparente a los 
efectos atmosféricos. 

 
3. Resolución Radiométrica: Este concepto está relacionado con la sensibilidad del 

sensor, es decir, con la capacidad de detectar variaciones en la radiancia espectral que 
recibe. Se expresa en el número de bits de cada uno de los elementos contenidos en 
la imagen. Generalmente es 8 bits (28 =  256 niveles por píxel). Cuanto mayor es el 
número de bits, mayor será la cantidad de cifras significativas de los valores de 
radianza registrados. 

 
Tabla 1.1: Resolución Radiométrica 

BITS NIVELES DE GRIS RAGO B- N 
1 2 0-1 
2 4 0-3 
3 8 0-7 
4 16 0-15 
5 32 0-31 
6 64 0-63 
7 128 0-127 
8 256 0-255 
9 512 0-511 
10 1024 0-1203 

 
4. Resolución Temporal: Es la frecuencia o periodicidad con que el sensor adquiere 

imágenes de la misma área de superficie terrestre, siempre en función de las 
características orbitales del satélite (altura, velocidad e inclinación) y de las 
características del sensor. 

 
 
 



 
 

 

20 
 

1.8.5. Imagen Satelital 
 
Las imágenes de satélite representan las formas de captura indirecta de la información 
espacial y tienen un valor proporcional a la reflectancia del suelo para el área de la imagen. 
Además, son la representación gráfica de un arreglo en forma de matriz en el que cada 
elemento corresponde al valor de una posición determinada (X, Y, Z).  
 
Para las imágenes de satélite, el sensor detecta la radiación media de una zona del terreno 
equivalente al tamaño de la unidad visual más pequeña que aparece en la imagen, como 
ya se mencionó antes, se trata del píxel. Este valor medio es traducido por el sensor a un 
valor numérico entero, denominado Nivel Digital, que también es llamado valor de brillo, 
valor de píxel o escala de grises. Así se conforma una matriz con los valores registrados de 
norte a sur, en las filas, de occidente a oriente en las columnas de la matriz, y el arreglo 
de bandas determinado por la resolución espectral, que determinan el número de planos 
en la imagen según el número de bandas registradas por el sensor (Figura 1.6). Por la 
naturaleza del proceso de adquisición de estas imágenes de satélite, los objetos 
geográficos están contenidos en la imagen y para individualizarlos (para la reproducción 
de salidas en forma de mapas, informes, archivos digitales, etc.) es necesario recurrir a 
técnicas de procesamiento y de clasificación automatizada. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 1.6: Representación de la imagen de satélite 
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Las imágenes satelitales están confeccionadas por matrices, en las que cada celda 
representa un píxel, las dimensiones de este píxel dependerá de la Resolución espacial 
del sensor. Los sensores registran la radiación electromagnética que proviene de las 
distintas coberturas y las almacena en cada píxel. Es importante aclarar que cada sensor 
detecta la región del espectro electromagnético para la cual fue diseñado. Esta energía 
electromagnética es representada en cada píxel por un valor digital al cual se le agrega 
una tonalidad, este valor es llamado Nivel Digital (ND), la cantidad de niveles digitales 
que se podrá representar dependerá de la Resolución Radiométrica del sensor. Para un 
sensor con Resolución Radiométrica de 8 bit los niveles digitales varían entre 0 y 255, 
siendo en la escala de grises el cero igual al color negro y el 255 igual al color blanco. 
 
La posición de cada píxel en la imagen satelital está determinada por un eje de 
coordenadas (X, Y, Z), de tal manera que X: No de columna de la matriz. Y: No de fila de la 
matriz. Z: Nivel digital (valor de intensidad de la escala de grises). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 1.7: Representación de una imagen satelital. 

 
Las diversas coberturas emiten radiaciones electromagnéticas en variadas longitudes de 
onda, lo que hace que las bandas las representen en forma distinta. Para obtener una 
mejor interpretación se realiza una formación aditiva, en la que se asigna colores a los 
ND (Niveles Digitales) en forma arbitraria y así obtener una imagen color compuesto. El 
monitor de una computadora genera todos los colores mediante la combinación de tres 
cañones: azul, verde y rojo. 
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Si uno asigna la información de los píxeles de la banda espectral de un sensor 
correspondiente a la región azul al cañón azul, análogamente la verde al cañón verde y 
la roja al cañón rojo se obtiene una imagen de color real. En el caso del sensor TM de 
LANDSAT5 una imagen compuesta de esta manera se denomina LANDSAT5-TM 321, 
que significa que la banda TM3 se graficó en el rojo, la TM2 en el verde y la TM1 en el 
azul. 
 

1.8.6. Fundamentos de la Teledetección 
 
La Teledetección utiliza como información la energía radiante emitida, rejeada, 
transmitida o dispersada por la materia a partir de una fuente de radiación natural o 
artificial. Esta información se puede registrar en uno o más intervalos de longitudes de 
onda del espectro electromagnético, según el tipo de sensor que se utilice. Para que una 
especie química sea detectada desde el espacio es necesario que presente una interacción 
con la radiación electromagnética dentro del intervalo espectral del instrumento de 
medición y además que esté en una concentración que genere una respuesta apreciable. 
 
Los principios físicos involucrados en el sensado remoto son aquellos que describen la 
interacción entre la radiación electromagnética y la materia: 1. Reflexión, 2. Refracción, 3. 
Dispersión, 4. Absorción, 5. Emisión. 
 
La Figura 1.8 muestra la descomposición de la radiación solar incidente sobre la 
superficie terrestre, la cual se puede describir mediante la ecuación (Ec. 1.2): 
 

𝝓𝝓𝒊𝒊 = 𝝓𝝓𝒓𝒓 + 𝝓𝝓𝒂𝒂 + 𝝓𝝓𝒕𝒕       (Ec. 1.3) 
 

      

 
 
 
 
 
 
 
 
 
 
 

Figura 1.8: Descomposición de la radiación incidente. 
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Nótese que 𝜙𝜙𝑖𝑖  es la radiación solar incidente, 𝜙𝜙𝑟𝑟  es la radiación reflejada, 𝜙𝜙𝑎𝑎  es la 
radiación absorbida por la zona iluminada y 𝜙𝜙𝑡𝑡 es la radiación transmitida a través de la 
superficie. De acuerdo con el principio de conservación de la energía y considerando la 
ley de Snell se obtiene la ecuación (Ec. 1.3). 

 
𝟏𝟏 = 𝝓𝝓𝒓𝒓

𝝓𝝓𝒊𝒊
+ 𝝓𝝓𝒂𝒂

𝝓𝝓𝒊𝒊
+ 𝝓𝝓𝒕𝒕

𝝓𝝓𝒊𝒊
     (Ec. 1.4) 

 
La ecuación (Ec. 1.3) se suele reescribir como la ecuación (Ec. 1.4) de manera de identificar 
cada término con alguna propiedad del sistema que brinde información sobre la 
naturaleza física y química de la superficie iluminada. 

 
𝟏𝟏 = 𝝆𝝆𝝀𝝀 + 𝜶𝜶𝝀𝝀 + 𝝉𝝉𝝀𝝀     (Ec. 1.5) 

 
Donde 𝜌𝜌𝜆𝜆 es la reflectancia, 𝛼𝛼𝜆𝜆 es la absorbancia, 𝜏𝜏𝜆𝜆 es la transmitancia y el subíndice 𝜆𝜆 es 
la longitud de onda a la cual se miden estas magnitudes. Es importante notar que la 
proporción de cada una de ellas en la ecuación (Ec. 1.4) depende de la longitud de onda 
incidente. 
 
1.8.7. Fuente de radiación 

 
Las fuentes de radiación involucradas en el sensado remotos pasivos de la Tierra son 
principalmente el Sol, la Tierra y la Atmosfera, en un grado menor. En el caso de estudios 
atmosféricos se puede llegar a utilizar la luz de las estrellas o de la Luna, (D. Rodgers). 
Un ejemplo de esto último es el sensor GOMOS (The Global Ozone Monitoring by 
Occultation of Stars) a bordo del satélite europeo ENVISAT. Una fuente de radiación 
puede modelarse como un cuerpo negro en equilibrio térmico mediante la ecuación de 
Planck (2.5) donde la intensidad de emisión es una función de la longitud de onda: 

 

𝑰𝑰𝝂𝝂 = 𝑩𝑩𝝂𝝂(𝝂𝝂,𝑻𝑻) = 𝟐𝟐𝟐𝟐𝝂𝝂𝟑𝟑

𝒄𝒄𝟐𝟐�𝒆𝒆(𝒉𝒉𝒉𝒉/𝑲𝑲𝑲𝑲)−𝟏𝟏�
    (Ec. 1.6) 

 
Donde 𝐼𝐼𝜈𝜈 es la intensidad específica [𝑊𝑊 𝑚𝑚−2 𝐻𝐻𝑧𝑧−1 sterad-1], 𝜈𝜈 la frecuencia [𝐻𝐻𝐻𝐻 =  1/𝑠𝑠 ],𝑇𝑇 
la temperatura [ 𝐾𝐾𝑜𝑜 ], ℎ  la constante de Planck ( 6,63 × 1034 𝐽𝐽𝐽𝐽 ) y 𝑘𝑘  la constante de 
Boltzmann (1,38 × 1023 𝐽𝐽𝐾𝐾−1 ). A partir de la ecuación (Ec. 1.5) se puede ver que la 
intensidad de emisión depende sólo de la temperatura del cuerpo negro, pero no 
directamente de su naturaleza química (a pesar que su temperatura depende de las 
propiedades del medio). 
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El sol y las estrellas pueden ser descriptos como capas concéntricas de gases en equilibrio 
térmico, y en este marco el espectro solar puede ser aproximado al de un cuerpo negro a 
5900 𝐾𝐾. En el caso de la Tierra, esta se puede describir como un cuerpo negro que se 
encuentra en promedio a 288 𝐾𝐾 . La Figura 1.2 muestra estos aspectos. A mayor 
temperatura el pico del espectro se corre hacia longitudes de onda más cortas y la 
cantidad de energía irradiada por segundo a partir de cada metro cuadrado de la fuente 
aumenta. Es decir que la emisión de la superficie terrestre depende de su temperatura. 
 
1.9. EL AGUA EN EL ESPECTRO ÓPTICO 
 
En este trabajo nos interesa la respuesta espectral del agua frente a la perturbación de la 
radiación solar en el rango de detección del sensor TM de la plataforma satelital 
LANDSAT-5 (Chander , Markham and Helder). El comportamiento óptico de los 
sistemas de aguas naturales dependen de sus características físicas y químicas. A 
continuación, se presentan los principios físicos que permiten el diseño de un plan de 
monitoreo desde el espacio, en particular de concentración de clorofila-a. 
 
Las aguas naturales presentan sustancias ópticamente activas que determinan finalmente 
el comportamiento espectral de estos sistemas de estudio. En la comunidad científica se 
conocen estas propiedades como SIOPs, Propiedades ópticas inherentes específicas (del 
inglés Specific Inherent Optical Properties (Schalles F., Campbell , Phinn  and Daniel). 
 
Entre las principales propiedades ópticas que incluyen en un espectro de reflectancia de 
aguas naturales se pueden citar: 
 
1. Coeficiente de absorción debido a la presencia de materia orgánica coloreada o 

también llamada materia amarilla, aCDOM. 
 

2. Coeficiente de absorción debido a la presencia de excrementos de la ora y fauna 
acuática, denominados en inglés tripton, aTR. 
 

3. Coeficiente de absorción debido a la presencia de fitoplancton, el cual abarca 
clorofila-a, ficocianina, carotenos entre otros, aФ. 
 

4. Coeficiente de retrodispersión causado principalmente por la materia en suspensión 
o también denominado material particulado, bbp. 

 
Cabe aclarar que cada una de estas propiedades son funciones de la longitud de onda a 
la cual se lleva a cabo la medición de reflectancia. Por otro lado, las tres primeras sumadas 
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a la absorción del agua se aproximan al coeficiente de absorción total de un agua natural, 
el cual se denomina a. La palabra aproximadamente se debe a que cualquier compuesto 
que se encuentre en un sistema acuático y presente absorción a la longitud de onda de 
medición va a aportar al valor de a. 
 
Morel y Prieur propusieron una clasificación de aguas oceánicas en función de la 
influencia de las partículas disueltas o en suspensión sobre sus propiedades ópticas, 
(Morel and L. Prieur): 
 
• Tipo I 
• Tipo II 

 
La clasificación realizada por Morel está muy difundida en la comunidad científica y se 
utiliza también para caracterizar aguas continentales [76]. Las aguas Tipo I son aquellas 
en las cuales el fitoplancton es el factor determinante de las propiedades ópticas. Este 
supuesto se puede verificar mediante una regresión lineal entre concentración de 
clorofila-a y materia en suspensión. Cuando esta relación es significativamente lineal 
entonces se puede trabajar bajo la aproximación de un agua Tipo I, mientras que si no lo 
es el agua se clasifica como Tipo II. Esto significa que la materia orgánica, humus o 
sustancia amarilla y material en suspensión contribuyen de manera independiente y 
significativamente a la respuesta espectral del sistema en el rango óptico. Es importante 
la introducción de este concepto debido a que el cálculo de concentración de clorofila-a a 
partir de espectros de reflectancia de aguas tipo II es mucho más complejo que el que 
requiere un agua de Tipo I, ya que se deben utilizar sensores de mayor resolución 
espectral que los que se encuentran a bordo de los satélites de la serie LANDSAT. 
 

1.9.1. Procesamiento digital 
 
Puede ser definido como el conjunto de tecnologías orientadas a la recopilación y 
tratamiento de información espacial con un objetivo en específico (Carranza, 2007). 
Dichas tecnologías incluyen el uso de hardware y software, que permiten con las 
imágenes de satélite, visualizar, estudiar, y analizar el territorio con una facilidad y 
flexibilidad difícilmente abordable por otros medios. 
 
El primer proceso, también llamado operaciones de pre-procesamiento (Rullan, 2002) 
consiste en corregir distorsiones o degradaciones de los datos de la imagen y crear una 
representación más fiel de la escena original; distorsiones geométricas a corregir de los 
datos crudos de la imagen, calibrar los datos radiométricamente y eliminar el ruido 
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presente en los datos. Dicho proceso depende directamente de las características del 
sensor usado para adquirir los datos. 
 
Georreferencia: Es una modificación geométrica de la imagen que pretende corregir los 
errores sistemáticos derivados de la rotación terrestre o de la inclinación de la órbita, 
parte de los datos orbítales del sensor y del relieve angular de la toma. Se trata del ajuste 
de la imagen a una cartografía básica o a otra imagen tomada como referencia; ambos 
casos requieren de tres pasos que son la localización de puntos de control o comunes a 
ambas imágenes o al mapa; aplicación de una función de transformación de las 
coordenadas de la imagen a las coordenadas de referencia, en este caso si la imagen es de 
un terreno muy accidentado conviene utilizar el cálculo de una función polinomial más 
compleja (de segundo o tercer orden de manera conjunta con un Modelo Digital de 
Elevación), y por último pasar los valores de los Niveles Digitales de la imagen original 
a su nueva posición corregida mediante una de las tres funciones siguientes: el vecino 
más próximo, por interpolación bilinear o por convolución cúbica. 
 
De  acuerdo al  INEGI  (2005) el  Modelo Digital  de  Elevación  es  un grupo de valores 
que representa puntos sobre la superficie del terreno cuya ubicación geográfica está 
definida por coordenadas "X" y "Y" a las que se les agrega un valor de "Z" que 
corresponde a la elevación. La coordenada "Z" es obtenida a partir de las de curvas de 
nivel vectorizadas de la carta topográfica escala 1:50 000 o por el método fotogramétrico 
de correlación de imágenes. Las variaciones topográficas en la superficie de la tierra y la 
inclinación del satélite o sensor afectan la distancia con la que se muestran las 
características en la imagen satelital o aérea. Cuanto más topográficamente diverso sea el 
paisaje, tanto mayor será la distorsión inherente en la imagen. 
 
Para realizar una corrección Geométrica del efecto topográfico es preciso contar con un 
DEM. En el terreno de la corrección geométrica, el uso de los DEM implica habitualmente 
realizar rectificación diferencial, en donde cada Nivel Digital se trasfiera separadamente 
desde la imagen original a la resultante a partir de corregir la posición del píxel en función 
del desplazamiento debido al relieve (Pala y Pons, 1995). 
 
Realce de la imagen. Se realiza para mejorar el aspecto al momento de hacer 
interpretaciones visuales. El realce de la imagen implica técnicas para el aumento de los 
rasgos distintivos entre características visuales. Chuvieco (2002) menciona la mejora del 
contraste, composiciones coloreadas, cambios de escala y filtrajes. El objetivo es aumentar 
la cantidad de información que puede ser visualmente interpretada.  
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Después las operaciones de pre-procesamiento, se aplica el tratamiento digital para 
generar información de la cubierta del suelo. Este método permite realizar operaciones 
complejas o inaccesibles al análisis visual. Garantiza una clasificación más rápida de la 
zona de estudio, manteniendo una coherencia en la asignación de áreas vecinas a dos 
categorías, a la vez que permite generar la distribución espacial de variables biofísicas 
(temperatura, clorofila en el agua, etc.), y simplifica la determinación de cambios 
temporales: 
 
Clasificación de la imagen.  
 
Básicamente consiste en dividir el conjunto de píxeles que componen la imagen, y 
agruparlas en categorías temáticas, en donde ya no tendrán sus valores en Niveles 
Digitales sino como inventario de un objeto de estudio. Durante la clasificación digital se 
requiere el uso de métodos que incorporen reglas de decisión, los cuales se pueden 
agrupar en dos categorías: los supervisados y los no supervisados. 
 
Clasificación supervisada.  
 
Funciona a partir de un cierto conocimiento de la zona a clasificar, adquirido por 
experiencia previa o por trabajos de campo del área en estudio. Esto permite delimitar 
áreas representativas de las categorías analizadas (sitios de entrenamiento). A partir de 
aquí se calculan los Niveles Digitales que definen las clases. El usuario define los campos 
de entrenamiento para las diferentes categorías que quedarán agrupadas de acuerdo a 
sus respuestas espectrales. En este caso se dispone de un conjunto de observaciones 
multivariadas, para las cuales se conocen a priori las clases a las que pertenecen, es decir 
la variable respuesta está definida. 
 
Clasificación no supervisada.  
 
Los píxeles son asignados a distintos cluster sin necesidad de tener conocimiento previo 
del área examinada, ni de la existencia de posibles patrones homogéneos en ella. El 
objetivo es relacionar las clases obtenidas con objetos reales cuya existencia, 
características y diferencias se pueden comprobar en campo (CIOMTA, 2004). Este 
método no implica conocimientos previos del área de estudio, de modo que la 
intervención del investigador se orienta hacia la interpretación de los resultados; por 
tanto, en donde la clasificación de los píxeles se realiza sin seguir ningún tipo de criterio, 
únicamente definiendo grupos de clases espectrales, asumiendo que los niveles digitales 
de la imagen forman una serie de grupos o conglomerados (clusters). En este caso se 
dispone de un conjunto de observaciones multivariadas, pero no se conocen las clases a 



 
 

 

28 
 

las que pertenecen. Estos grupos de píxeles serían equivalentes en términos de su 
comportamiento espectral más bien homogéneo y, por tanto, deberían definir clases 
temáticas de interés. 
 
Resultados.   
 
Independientemente del   método empleado en la clasificación digital, los resultados se 
almacenan en una nueva imagen que es similar a las originales en cuanto a su estructura 
y tamaño, pero con la diferencia de que el Nivel Digital de cada píxel no corresponde a 
un valor de reflectividad, sino a la categoría que se le asigno (Ruíz, 2006). Esta nueva 
imagen da lugar a dos productos: uno cartográfico y otro estadístico. 
  

1.9.2. Análisis Visual 
 
En este marco, se puede aprovechar la potencia de análisis de interpretación visual 
(incluyendo criterios de contexto, textura, formas complejas que puede  emplear  el  
intérprete),  así  como  la  flexibilidad  y potencia del tratamiento digital (imagen 
georreferenciada, mejoramiento en su aspecto visual, digitalización de la información en 
pantalla, etc.). Se trata de una fotointerpretación asistida por el ordenador, que elimina 
diversas fases de la interpretación visual clásica (restitución, inventario). Con la 
interacción visual con el intérprete se pueden resolver algunos problemas del tratamiento 
digital, que encuentra notables dificultades para automatizar la interpretación de ciertos 
rasgos de la imagen (algunas nubes, áreas urbanas, etc.) que son bastante obvios al 
análisis visual (Paniagua, 2006) (Carranza y Paniagua, 2007). 
 
Es una alternativa para modificar la cartografía generada a partir de un análisis digital, 
identificando clases heterogéneas. Auxilia la clasificación digital, aislando sectores de 
potencial confusión sobre la imagen, o estratificando algunos sectores de la imagen para 
aplicarles tratamientos específicos. 
 

1.9.3. Detección de cambios en las cubiertas del suelo 
 
De acuerdo con Singh (1989), la detección de cambio, es el proceso de identificar 
diferencias en el estado de un objeto observado en diferentes tiempos. También hace 
mención a los productos generados a partir de la percepción remota, los cuales, gracias a 
la cobertura repetida en intervalos cortos de tiempo y una constante calidad de la imagen, 
son ideales para la detección de cambios en las cubiertas del suelo. 
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En la actualidad los estudios sobre los procesos dinámicos de los cambios en la cobertura 
del suelo y la deforestación son importantes y necesarios porque proporcionan la base 
para conocer las tendencias de los procesos de degradación, desertificación y pérdida de 
la biodiversidad de una región determinada. La naturaleza intrínseca de los ecosistemas 
encierra como motor inherente una serie de aspectos dinámicos. Durante las últimas 
décadas, no obstante, el hombre (originalmente considerado como una especie más y 
sujeta a la dinámica propia de cada ecosistema) se ha convertido en el principal 
desencadenador de la actividad transformadora de los ecosistemas (Velázquez, Mas, 
2002). 
 
La presión que ejerce el hombre sobre los recursos naturales, en un principio para cubrir 
las necesidades básicas, las cuales han aumentado junto con el crecimiento de la 
población, hasta la sobreexplotación generada por la comercialización del recurso, ha 
llevado a que los niveles de pérdida actual de la vegetación primaria sea alta debido 
principalmente a la conversión de masas forestales en áreas agrícolas y ganaderas por 
medio de talas, incendios, así como eventos naturales que modifican las coberturas del 
suelo (deslaves, inundaciones, terremotos, etc.). Entre las principales aplicaciones 
potenciales son la identificación de los relevantes focos de cambio y sus procesos 
asociados (e.g., deforestación, fragmentación). En consecuencia, se podrán medir las 
implicaciones ambientales o sociales de estos cambios probables, sus repercusiones 
económicas y establecer mecanismos de control de las causas de origen, así se ayudaría a 
generar un sistema de seguimiento y actualización periódicos. Analizar la situación 
actual y potencial de los bienes y servicios ambientales en general derivada de un buen 
inventario de sus recursos naturales y su dinámica. Entre los servicios y bienes de 
consumo directo destacan el agua y la masa forestal. 
 
La detección de cambios sobre las cubiertas del suelo utilizando imágenes de satélite, ha 
sido muy estudiado. Más aplicaciones de este tipo, incluye cualquier diferenciación de 
imágenes o su clasificación, utilizando una escala multitemporal (Yu-Chuan et al. 2000). 
 
En la Tabla 1.2 se muestra el resumen modificado por Lu (2004) y Mas (2000), y utilizado 
por González (2006), en la cual se exponen las principales técnicas de detección de 
cambios en percepción remota, incluyendo las principales ventajas y desventajas de cada 
una de ellas. González (2006), hace referencia a que en recientes años se han desarrollado 
nuevos algoritmos, y marca como ejemplo el Análisis Espectral de Mezcla y SIG con 
teledetección.  Previa investigación ha mostrado que la combinación de dos o más 
técnicas de detección de cambio puede proveer mejores resultados que utilizando 
únicamente un solo algoritmo. 
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Tabla 1.2: Principales técnicas de cambio que utilizan una comparación post-
clasificación. 

COMPARACIÓN POST- CLASIFICACIÓN 

COMPARACIÓN 
POST- 

CLASIFICACIÓN 
CARATERÍSTICAS VENTAJAS DESVENTAJAS 

 
Clasificación no      

supervisadas 

Clasificación de imágenes 
independientes, entonces 

implementa la comparación de las 
imágenes 

Clasificadas píxel por pixel. 

Corrección radiométrica 
no es necesaria. 

Minimiza impactos 
atmosféricos, y del 

sensor. 

Dificultad al analizar 
los clusters de las 
clasificaciones 

independientes. 

Clasificaciones 
supervisada 

 
 

Comparación de las imágenes 
clasificadas independientemente 

Corrección radiométrica 
no es necesaria. Minimiza 
impactos atmosféricos, y 

del sensor. Provee  una 
matriz completa de la 

información de cambio. 

Requiere mucho 
tiempo además de la 

fiabilidad final 
depende de la 
calidad de las 

imágenes clasificadas 
para cada fecha. 

Expectación 
maximización 

Es un método de clasificación 
usando un algoritmo de 

expectación maximización (EM) 
para estimar a priori las clases 

comunes entre dos fechas. Estas 
probabilidades son estimadas 

directamente de las imágenes bajo 
análisis. 

 
El método ha reportado 

una gran fiabilidad al 
detectar cambios. 

 
Requiere estimar la 

probabilidad de 
clases comunes a 

priori. 

Redes neuronales 
artificiales (ANN) 

Usa campos de entrenamiento. 
Entonces las redes neuronales son 
los datos espectrales del período 

de cambio. Un algoritmo de 
propagación es muchas veces 

usados para entrenar el modelo 
multicapas de percepción de redes 

neuronales. 

Es un método 
supervisado no 

paramétrico y tiene la 
habilidad de estimar las 

propiedades de los 
cambios basados en los 

campos de 
entrenamiento. 

La naturaleza de las 
capas ocultas, es 

pobremente 
conocida, además es 

muy sensitivo a la 
suma de los datos de 

entrenamiento 
usados. Las 

funciones ANN no 
son comunes en el 
procesamiento de 

imágenes. 
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El análisis post-clasificatorio utilizando matrices de detección de cambio, permiten 
comparar dos mapas temáticos, producidos independientemente (Sing, 1989), y con 
métodos de Sistemas de Información Geográficos (SIG). 
 
La matriz de detección de cambios, contiene información de transformación de una clase 
a otra y su arreglo permite el cálculo de cambio en conjunto y por categoría. Los datos 
que se encuentren en la diagonal, representan la superficie sin cambio dentro del periodo, 
mientras los datos fuera de la diagonal, representan los cambios de una clase a otra en 
forma de ganancia o pérdida (renglones y columnas respectivamente) entre las dos fechas 
(Congalton y Green, 1999). 
 
El método de interpretación interdependiente de la FAO (1996, 2000), indica que se 
marquen en su totalidad todos los polígonos de la primera fecha, para utilizarlos como 
base de interpretación de las siguientes fechas, únicamente modificando los polígonos en 
los cuales se detecten transformaciones. De acuerdo con Ramírez y Zubieta (2005), este es 
un método muy efectivo por que ayuda a reducir al mínimo los errores más comunes que 
llevan a la detección de falsos cambios: 1) errores de posición, el intérprete puede posibles 
desplazamientos entre las imágenes, y  no  señalarlos  como  cambios;  2)  errores  de  
clasificación,  el  método permite moverse fácilmente de una fecha a la otra, por lo que el 
intérprete puede reconocer si se trata de verdaderos cambios o sólo de diferencias en la 
respuesta espectral de las cubiertas 
 
La cuantificación de cambio resulta de la diferencia mediante sobreposición cartográfica 
entre los mapas de cobertura de una fecha base y una fecha a comparar, de ello resulta 
una matriz de cambio, con un valor cada clase que ha cambiado (más dinámicas), y una 
indicación de aquellas clases que no han cambiado (más estables). También se deriva una 
evaluación de clases de cobertura y uso atractoras de territorio de otras clases y de 
cobertura que pierden territorio con otras clases (IFN, 2000). 
 
1.10. CÁLCULO DE LOS ÍNDICES DE VEGETACIÓN  
 
La firma espectral de una masa de hojas Figura 1.9 presenta tres zonas diferenciadas del 
espectro electromagnético: el visible, el infrarrojo próximo y el infrarrojo medio.  
 
• En el visible la reflectancia es baja y también la transmitancia, debido la absorción de 
pigmentos fotosintéticos (clorofila, xantofila, antocianinas y carotenos).   
 
• En el infrarrojo próximo, las hojas presentan una meseta alta de reflectancia (alrededor 
de 50%). El resto de energía es transmitida.   
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• En el infrarrojo medio, el agua marca su presencia en las hojas produciendo fuertes 
bandas de absorción en la signatura resultante.    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 1.9: Firma espectral de la vegetación. 

 
La vegetación vigorosa absorbe la radiación en la zona del visible, especialmente en el 
rojo (0,6 − 0,7) en tanto que refleja gran parte de la que le incide del infrarrojo próximo 
(0,7 − 1,1).  Para estudiar la cobertura vegetal de una zona mediante imágenes de satélites, 
se han desarrollado diversas técnicas que permiten tener datos cualitativos y 
cuantitativos del estado de la vegetación. Los índices espectrales de vegetación son 
transformaciones desarrolladas para caracterizar las cubiertas vegetales reforzando la 
contribución espectral debida a la cubierta vegetal, en tanto que minimizan la influencia 
de factores distorsionantes como el suelo, la irradiancia solar, el ángulo de elevación solar 
y la propia atmósfera (Pinilla 1995).  
 
De acuerdo a la recopilación de indicadores, realizada por García (2011) los índices de 
vegetación parten del supuesto de que la vegetación tiene un comportamiento distinto 
en cada longitud de onda en función de su estado vegetativo y desarrollo alcanzado, y 
consisten en la combinación de bandas espectrales de la vegetación al tiempo que atenúan 
las de otros factores como el suelo, y las condiciones de iluminación y atmosféricas. 
 
1.11. ÍNDICE DE VEGETACIÓN DE DIFERENCIA NORMALIZADA (NDVI)  
 
La formulación original es atribuida a Rouse et al. (Rouse J. et al, 1973) para caracterizar 
la cubierta vegetal de la superficie terrestre y difundido en un principio por Tucker et al. 
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(Tucker C.J. et al, 1979). Se calcula a partir de mediciones de reflectancia, este índice ha 
sido y está siendo ampliamente utilizado, estando basado en un intento de realzar las 
diferencias en la reflectividad entre las regiones espectrales del rojo y el infrarrojo cercano.  
El NDVI es un índice derivado de las medidas de los valores de la reflectancia en la banda 
roja (banda 3) y el infrarrojo cercano (banda 4) del espectro electromagnético que describe 
la cantidad relativa de biomasa de una región a otra (Lillesand y Kieffer, 1987). Se calcula 
mediante la fórmula. 
 

𝑵𝑵𝑵𝑵𝑵𝑵𝑵𝑵 = 𝝆𝝆𝑵𝑵𝑵𝑵𝑵𝑵−𝝆𝝆𝑹𝑹𝑹𝑹𝑹𝑹
𝝆𝝆𝑵𝑵𝑵𝑵𝑵𝑵+𝝆𝝆𝑹𝑹𝑹𝑹𝑹𝑹

   (Ec. 1.7) 

 
Donde:  
𝜌𝜌𝑁𝑁𝑁𝑁𝑁𝑁 = reflectancia en la banda 4 (infrarrojo Cercano)  
𝜌𝜌𝑅𝑅𝑅𝑅𝑅𝑅 = reflectancia en la banda 3 (rojo) 
 
NDVI puede adquirir valores comprendidos entre −1 y 1. Están definido en un intervalo 
que va desde −1  hasta 1 . Los mayores valores de NDVI corresponden a vegetación 
vigorosa, mientras que valores negativos pueden indicar presencia de agua o de zonas 
desiertas. Luego, para los valores que se encuentran entre 0  y 0,5  existen múltiples 
interpretaciones que dependen de la zona de estudio. El valor 0 corresponde a suelo 
completamente desnudo, sin vegetación) y 1  a suelo con una cubierta de biomasa 
máxima. Se puede presentar el caso en que NDVI presente valores negativos, lo que 
indicaría presencia de lámina de agua, nieve, nubes.  
 
La importancia de este índice reside en su utilidad para determinar la presencia de 
vegetación, y realizar un seguimiento en su desarrollo. Así pues, permite determinar la 
eficiencia metabólica de la vegetación o localizar áreas donde el crecimiento de la 
vegetación es menor, distinguir vegetación sana, o vegetación con estrés por falta de agua, 
sequía, etc.  
 
Para el cálculo del NDVI se utiliza la formulación (Ec. 1.7), pero las bandas utilizadas son 
diferentes dependiendo del sensor. El infrarrojo cercano corresponde a la banda 3, y el 
rojo a la banda 2 para Landsat, y en el cálculo de NDVI para MODIS se emplearían las 
bandas 1 y 2, siendo para este estudio en el sensor IKONOS las bandas 3 y 4, para LIDAR 
3 y 4. 
 
A modo de ejemplo se presenta dos imágenes en la Figura 1.10 de la distribución espacial 
de NDVI para las estaciones de invierno y verano. Para la imagen de invierno se observan 
valores elevados de NDVI próximos a 1(representados con tonos verdes oscuros) que se 
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corresponden a zonas montañosas con vegetación. La otra imagen correspondiente a 
verano, los valores no son tan altos como en invierno, ganando espacio los tonos 
marrones, próximos a 0. 
 
 
 
 
 
 
 
 
 
 
 

Figura 1.10: NDVI de invierno y verano de la Cuenca del Rio Segura, España. [Josefa Gil]. 
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2. DISEÑO METODOLÓGICO  

Análisis del cambio de uso/cobertura de suelo y NDVI usando QGis y ERDAS IMAGINE 
(programa integrado de proceso de imágenes satelitales y Sistemas de Información 
Geográfica (SIG), está dirigida principalmente al procesamiento de datos de trama 
geoespacial. Desarrollado por Hexagon Geospatial (anteriormente ERDAS, Inc.). 
Proporciona herramientas de análisis geoespacial de imágenes de fuentes diversas, 
satélite, vuelo aéreo, drones, sensores LiDAR, datos Radar, para la generación de nueva 
información). 
 
Para de analizar y determinar el cambio de uso/cobertura de suelo y NDVI se debe tener 
una idea de que datos y herramientas serán de utilidad, para nuestro caso, por el método 
de Clasificación elaborado por Chuvieco. 
 
Insumos para la investigación 
• Imágenes satelitales. 
• Cartografía de la zona de estudio. 
• GPS Garmin. 

 
2.1. DESCRIPCIÓN DEL ÁREA DE ESTUDIO 
 

El área de estudio (Figura 2.1, Figura 2.2) se localiza en el norte de El Salvador, En el 
departamento de Chalatenango. Se enmarca entre los 13°59'44.98"N, 88°58'50.99"O y los 
14° 7'58.50"N, 88°52'49.01"O, lo que corresponde a 101.78 𝐾𝐾𝑚𝑚2 que conforman el área de 
la cuenca, además, el río Tamulasco tiene una extensión de 30 𝐾𝐾𝐾𝐾 y nace en las laderas 
este de la Montañona aproximadamente y desemboca el Embalse Cerrón Grande, posee 
una elevación mínima de 244 𝑚𝑚  aproximadamente y una máxima de 1,450 𝑚𝑚 
aproximadamente, de manera que al poseer poco más de 1.2 𝑘𝑘𝑘𝑘  de altura y por el 
entorno geográfico montañoso a la cual pertenece la cuenca, es importante considerar 
tales elevaciones que caracterizan climáticamente a la zona montañosa del departamento 
de Chalatenango como un área de alta humedad atmosférica y nubosidad que permite el 
aporte significativo de agua para la cuenca del río Tamulasco. 
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Figura 2.1: Localización de la zona de estudio (MAG). [Fuente: SNET]. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figura 2.2: Vista satelital de la zona de interés (MAG). [Fuente: SNET]. 
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2.1.1. Descripción geológica de la zona 
 

La zona comprendida dentro del estudio presenta un relieve accidentado que va desde 
los 200 𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚 hasta 1400 𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚; un paisaje típicamente asociado a las estribaciones de la 
cadena volcánica antigua (Complejo Volcánico Chalatenango). Con un tipo de vegetación 
nativa que va desde Bosque húmedo subtropical hasta Bosque de subtropical de coníferas. 
 
En la Figura 2.3 se muestran los materiales geológicos presentes en la zona de estudio y 
su distribución espacial que afloran INCITU.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 2.3: Mapa geológico de la zona de interés (MAG). [Fuente: SNET]. 
 
Se describen a continuación los materiales geológicos que se encuentran en la zona de 
estudio y que pertenecen a las siguientes formaciones: 
 
San Salvador: 
1. Miembro Qf: Depósitos sedimentarios del Cuaternario.  

 
2. Sub miembros Q’c y Q’d: Depósitos fluviales con/sin representación de depósitos 

subyacentes (por ejemplo, ch2) y cono de deyección, respectivamente. 
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3. Miembro s4: Tierra Blanca: piroclastítas ácidas y epiclastítas volcánicas 
subordinadas: localmente efusivas ácidas (s3'b).  

 

Bálsamo: 
1. Miembro b1: Epiclastitas volcánicas y piroclastitas, localmente efusivas básicas-

intermedias intercaladas. 
 

2. Miembro b2: Efusivas básicas-intermedias, piroclastítas volcánicas subordinadas 
(estratos no diferenciados y edificios volcánicos). 
 

3. Miembro b3: Efusivas básicas-intermedias, piroclastítas volcánicas subordinadas 
(estratos no diferenciados y edificios volcánicos). 

 
Chalatenango: 
1. Miembro ch1: Piroclastítas acidas, ignimbrítas, epiclásticas, localmente efusivas 

acidas interaladas. 
 

2. Miembro ch2: Efusivas acidas, piroclastitas acidas subordinadas. 
 
Cuscatlán: 
1. Miembro c1: Piroclastítas acidas, epiclastítas volcánicas.  

 
2. Sub miembros cl y cf: Principalmente depósitos lacustres y Principalmente depósitos 

fluviales. 
 

3. Miembro c3: Efusivas básicas-intermedias. 
 
Morazán: 
Miembro m2’a: Efusivas intermedias hasta intermedias-acidas, piroclastítas 
subordinadas, alteración regional por influencia hidrotermal. (MARNMOP-IBERINSA-
EPYPSA, 2002). 
 
2.2. DISTRUCIÓN DE LAS CUENCAS Y SUBCUENCAS DE El SALVADOR 
 
En la Figura 2.4 se muestra el mapa de El Salvador con la distribución espacial de las 
cuencas hidrográficas del país. Puede observarse que la cuenca del Río Lempa no 
pertenece únicamente al país, sino que es compartida con Honduras y Guatemala. 
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En la Figura 2.5 se observa que el Río Tamulasco es un afluente al Río Lempa, por lo que 
en realidad se trata de una subcuenca del mismo. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 2.4: Mapa general de regiones hidrográficas de El Salvador [SNET/MARN]. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 2.5: Vista en detalle de la ubicación espacial de la subcuenca del Río Tamulasco. 
 
2.3. MATERIALES Y EQUIPO 
 
Los materiales y equipo que se utilizarán en el proyecto de investigación son los 
siguientes: 
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• Imagen de satélite IKONOS y LIDAR. 
• Modelo digital de terreno de 10 𝑚𝑚. 
• Cartografía vectorial. 
• Programas utilizados: ERDAS IMAGINE 2014 y QGis v.2.1819. 

 
2.4. ZONA DE ESTUDIO Y RECONOCIMIENTO DE CAMPO. 
 
La subcuenca del Río Tamulasco se encuentra ubicado en el departamento de 
Chalatenango, la vegetación principalmente es perteneciente a bosques húmedos 
subtropical con transiciones de húmedo a seco. Entre las actividades realizadas en la 
cuenca se citan el uso de las tierras en la agricultura de menor escala, pastoreo extensivo 
(el cual se transforma en intensivo en verano) trayendo consecuentemente problemas de 
deterioro del suelo y deforestación. Respecto al tratamiento de aguas negras de las 
ciudades situadas en la cuenca, no se cuenta con tratamiento de líquidos cloacales, pero 
se tiene un acuerdo municipal para no verter aguas al Río Tamulasco (sin embargo, es 
algo de poco a nada controlado por tratarse de diferentes municipalidades a las que la 
cuenca pertenece, véase ANEXO III). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 2.6: Mapa de ubicación de zona de estudio y de reconocimiento de campo (Elaboración propia). 



 
 

 

41 
 

Por otro lado, la ocurrencia de eventos impredecibles como los incendios y las crecidas 
de los cursos de agua, provocan una variabilidad espacial y temporal principalmente con 
el uso/cobertura de suelo. La Figura 2.4 muestra un mapa de ubicación de la zona de 
estudio y la Figura 2.6 muestra fotografías de la cuenca con los puntos de muestreo 
(reconocimiento de campo) que se realizaron durante el reconocimiento de campo. 
 

Tabla 2.1: Coordenadas de sitios recorridos. 

ID LATITUD LONGITUD DESCRIPCIÓN 
1 14.12283333333333 -88.90953833333333 Bosque de coníferas. 
2 14.118328333333332 -88.90401833333333 Fin de bosque de coníferas. 

3 14.119751666666666 -88.90121833333333 
Nacimiento de un afluente del 

Tamulasco. 
4 14.11857 -88.89783166666666 Uso pecuario. 
5 14.11756166666668 -88.89313166666668 Uso pecuario. 
6 14.118853333333334 -88.891505 Zona urbana y Bosque montañoso. 
7 14.096714999999998 -88.885965 Zona urbana y Bosque montañoso. 
8 14.096688333333335 -88.88618666666667 Zona urbana y Bosque montañoso. 
9 14.095533333333332 -88.88781666666667 Zona urbana y Bosque montañoso. 
10 14.086096666666666 -88.9000133333333 Bosque montañoso. 
11 14.084480000000001 -88.90087666666668 Bosque montañoso. 
12 14.08319000000002 -88.90135333333335 Bosque montañoso. 
13 14.081809999999999 -88.9017166666666 Bosque montañoso. 
14 14.080683333333331 -88.90567000000001 Bosque montañoso. 
15 14.07171 -88.90648833333334 Zona urbana. 
16 14.065733333333332 -88.90491833333333 Bosque montañoso. 
17 14.064183333333336 -88.90553333333334 Zona urbana y Bosque montañoso. 
18 14.062776666666666 -88.90480333333335 Bosque montañoso. 
19 14.062158333333333 -88.90485333333332 Bosque montañoso. 
20 14.060039999999999 -88.90478833333333 Zona urbana. 
21 14.056951666666665 -88.90397 Bosque montañoso. 
22 14.055256666666667 -88.90538166666666 Zona urbana y Pecuario. 
23 14.043136666666665 -88.91602166666668 Pecuario. 
24 14.042151666666665 -88.91693500000001 Zona urbana. 
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2.5. SENSOR UTILIZADO - IMÁGENES IKONOS 
 
El satélite IKONOS2 (Figura 2.7) es el primer satélite de tipo comercial que posibilita la 
captación de imágenes con un metro de resolución espacial. Estas imágenes son 
consecuencia directa de la liberación tecnológica promovida en 1994 por el gobierno de 
los Estados Unidos de América. Anteriormente a esa época esta tecnología estaba 
disponible para satélites con fines militares. IKONOS colecta información de cualquier 
área en promedio dos veces al día, cubriendo áreas de 20,000 𝑘𝑘𝑚𝑚2 en una misma pasada 
y produciendo como resultado imágenes de 1 metro de resolución cada tres días y de 2 𝑚𝑚 
de resolución todos los días. 
 
Principales características de satélite:  
• Fecha de lanzamiento del satélite: 24/09/99. 
• Lugar de lanzamiento: Vandenberg Air Force Base, California /USA. 
• Altitud: 681 𝑘𝑘𝑘𝑘. 
• Inclinación: 98.1º. 

• Velocidad: 7 𝑘𝑘𝑘𝑘
𝑠𝑠

. 

• Sentido de la órbita: descendente. 
• Duración de la órbita: 98 minutos. 
• Tipo de órbita: sincrónica con el sol. 
• Angulo de visada: rápida alternancia entre diferentes ángulos. 
• Tiempo de revista: 1 a 3 días. 
• Resolución en el terreno de cada banda:   
 

1. Pancromática: 1 𝑚𝑚 (considerando posición nominal de 26º para el nadir) 
2. Multiespectral: 4 𝑚𝑚 (considerando posición nominal de 26º para el nadir) 

 

• Bandas espectrales:  
 

1. Pan: 0.45 − 0.90 𝜇𝜇𝜇𝜇  
2. Azul: 0.45 − 0.52 𝜇𝜇𝜇𝜇  
3. Verde: 0.52 − 0.60 𝜇𝜇𝜇𝜇  
4. Rojo: 0.63 − 0.69 µ𝑚𝑚  
5. Infrarrojo próximo: 0.76 − 0.90 𝜇𝜇𝜇𝜇   

                                                 
2 El término "IKONOS" proviene del griego y significa "imagen" 
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• Rango Dinámico: posibilita que la información sea almacenada en 11 bits por píxel, 
con lo cual redunda en un mayor rango dinámico que facilita el contraste y 
discriminación de la información. No obstante, los productos pueden ser entregados 
al usuario en 8 bits por píxel.  (GeoService Perú).  

 
 
 
 
 
 
 
 
 
 

Figura 2.7: Satélite IKONOS (DIGITALGLOBE). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 2.8: Ficha técnica del Satélite IKONOS (DIGITALGLOBE). 
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2.6. MÉTODOS DE ANÁLISIS 
 
La metodología consiste básicamente en el procesamiento digital de imágenes satelitales 
del terreno del área de estudio, en combinación con el aspecto espacio temporal. El 
procesamiento digital de imágenes satelitales se utilizará para discriminar el área y 
obtención de la cartografía de uso/cobertura y NDVI, mientras que el aspecto espacio 
temporal de las imágenes permite el análisis de los cambios en la cuenca. 
 
En esta sección se mencionan las técnicas utilizadas para realizar el análisis de los datos 
de campo y elaborar los mapas temáticos basados en la información satelital. Para ello se 
utilizó el software ERDAS IMAGINE 2014 principalmente para el procesamiento de las 
imágenes satelitales y la elaboración de los mapas temáticos con QGis v.2.1819. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 2.9: Esquema del proceso metodológico en investigación de Teledetección (Chuvieco, 2008). 
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Las diferentes etapas de procesamiento se describen a continuación:  
 
Imágenes satelitales  
Las imágenes utilizadas para este análisis son IKONOS del 2003 e imágenes aéreas 
obtenidas del vuelo LIDAR del 2014 proporcionadas por el MARN. El procesamiento de 
las imágenes se fundamenta en la elaboración de algoritmos de discriminación de las 
áreas se uso/cobertura. Para ambas imágenes el enfoque se basa en la clasificación de 
categorías mediante AOI (áreas de interés) para los umbrales espectrales y el concepto de 
detección de cambios, por lo que se hace uros de la herramienta espacio temporalidad. 
Este procedimiento es considerando los años 2003 y 2014.  
 
Análisis Espacio Temporal 
El análisis del comportamiento espacio temporal del uso/cobertura y NDVI de la 
superficie de la cuenca, se realiza con los resultados de las imágenes IKONOS de 2003 y 
las imágenes del vuelo LIDAR del 2014. 
 
Con estas imágenes se realizan los siguientes análisis: 
 
1. Comportamiento del uso/cobertura de la superficie de la cuenca. En cada resultado 

de las imágenes procesadas se determina el área cubierta en la superficie de la cuenca 
para uso/cobertura con el propósito de conocer la distribución y cuantificación de 
estas áreas para determinar cuantitativamente los cambios o el comportamiento de la 
superficie de la cuenca. 
 

2. Comportamiento del NDVI. Nuevamente, en cada resultado de las imágenes 
procesadas de determinan los valores de NDVI con el propósito de conocer la calidad 
de la vegetación y los cambios o el comportamiento de la vegetación de la superficie 
de la cuenca. 
 

2.6.1. Pre-procesamiento 
 
En esta etapa se realizó la preparación de las imágenes satelitales, desde la composición 
de bandas espectrales, el mosaico de imágenes que contenían a al área de la Cuenca del 
Río Tamulasco y el recorte de la misma para trabajar con los datos que se encuentran 
dentro de la cuenca misma (Ver ANEXO I ). 
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2.6.2. Procesamiento 
 
En esta etapa se realizaron los procedimientos para las clasificaciones de uso/cobertura y 
el cálculo del NDVI con la finalidad de obtener la cartografía temática para cada una de 
las imágenes. Para conocer en detalle cada uno de los procedimientos realizados véase 
ANEXO II. 
 
Clasificación No Supervisada 
 

-Imagen IKONOS del 2003- 
Se inicia con la clasificación no supervisada correspondiente a la imagen IKONOS del 
2003, se define el archivo de salida, la aproximación al verdadero color y el número de 
clases, en este caso se realizó esta clasificación para 6 grupos de interés: 1. Agua/humedad, 
2. Bosque primario, 3. Bosque secundario, 4. Vegetación arbustiva, 5. Pasto/cultivo y 6. 
Zona urbanas/suelo desnudo. Luego se especifica el número de iteraciones en el proceso; 
(el máximo de iteraciones recomendadas es de 11) y finalmente se inicia la clasificación, 
como se muestra en la Figura 2.10. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 2.10: instrucciones del algoritmo de clasificación no supervisada usado. 
 
Una vez realizado el proceso, abrimos la nueva imagen para verificar los resultados. Este 
mapa es el primer mapa temático de la Cuenca del Tamulasco y este contiene los tipos de 
clases con nombre y correspondiente color, para la cual la información se encuentra en la 
tabla de atributos que se ubica en la parte izquierda de la imagen resultante, como se 
muestra en la figura siguiente (Figura 2.11). 
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Figura 2.11: Mapa temático resultado de la clasificación no supervisada y con su respectiva tabla de 
atributos para la imagen IKONOS del 2003. 

 
-Imagen LIDAR del 2014- 

Se realiza el proceso nuevamente para la imagen del vuelo LIDAR 2014 del área de trabajo, 
manteniendo los mismos parámetros utilizados para la imagen IKONOS del 2003 y 
nuevamente verificando el resultado obtenido como se muestra en la figura siguiente 
(Figura 2.12).  
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 2.12: Mapa temático resultado de la clasificación no supervisada y con su respectiva tabla de 
atributos para la imagen del vuelo LIDAR del 2014. 

 
Con esto finalizamos la clasificación no supervisada para ambas imágenes.  
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Clasificación Supervisada 
 

-Imagen IKONOS del 2003- 
Ahora seguiremos con la clasificación supervisada y comenzar a generar los AOI (Area 
Of Interest), para ello se crea un polígono con la muestra que queremos clasificar. Una 
vez seleccionados y agregados las firmas espectrales, en este caso se seleccionaron 12 
firmas para los 6 grupos de clases que definimos anteriormente, como se muestra a 
continuación en la Figura 2.13. 
 
 
 
 
 
 
 
 
 
 
 

Figura 2.13: Ventana que contiene las firmas espectrales de los grupos de clases de interés. 

 
Y la ubicación espacial de las mismas, se muestra a continuación en la Figura 2.14. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 2.14: Ubicación de los AOI para la imagen IKONOS del 2003. 
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Una vez definimos los AOI iniciamos la clasificación supervisada en el menú como se 
muestra la Figura 2.15. 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 2.15: Clasificación supervisada los grupos de clases de interés de acuerdo a las AOI definidas. 

 
Esta selección desplegará un menú, en el cual deberá seleccionarse el destino y el nombre 
del archivo de salida. Luego abrimos la nueva imagen para revisar los resultados 
obtenidos, y para un resultado más afinado, se establece una paleta de colores para 
facilitar la interpretación temática cartográfica, como se muestra en la Figura 2.16. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 2.16: Imagen resultante de la clasificación supervisada con su respectiva paleta de colores para 

facilitar la interpretación temática cartográfica  
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-Imagen LIDAR del 2014- 
Se realiza este proceso nuevamente con la imagen del vuelo LIDAR de 2014, 
seleccionando y agregando las firmas de clases. Al igual que en el caso anterior se 
seleccionaron 12 firmas y se verificaron los resultados de la clasificación como se muestra 
en la Figura 2.17. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 2.17: Mapa temático resultado de la clasificación supervisada con su respectiva tabla de 
atributos para la imagen del vuelo LIDAR del 2014. 

Con esto damos por concluido el trabajo en Erdas Imagine con lo que a las clasificaciones 
se refiere. 
 
Clasificación NDVI 
 

-Imagen IKONOS del 2003- 
 

Se realizó el proceso conocido como NDVI (Normalized Diference Vegetation Index), en  
la imagen a trabajar, como se muestra en la Figura 2.18, para conocer el índice de 
vegetación y la dinámica de cambio de cobertura de la zona de estudio. 
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Figura 2.18: Proceso inicial de NDVI en imagen satelital del sitio de interés. 

Al comenzar este proceso, se desplegará una ventana de trabajo como la mostrada en la 
Figura 2.19 en la cual se indica el sensor (IKONOS Multiespectral) y el nombre de salida 
de la imagen resultante. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 2.19: Selección de parámetros para la clasificación NDVI. 

 
Verificamos los resultados como se muestra a continuación. 
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Figura 2.20: Mapa temático resultado para NDVI para la imagen IKONOS del 2003. 

 
Con esto finaliza el procedimiento de clasificación NDVI la imagen IKONOS del 2003. 
 

-Imagen LIDAR del 2014- 
De la misma manera realizamos el proceso para la imagen más reciente y verificamos los 
resultados como se muestran a continuación. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 2.21: Mapa temático resultado para NDVI para la imagen del vuelo LIDAR del 2014. 
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3. RESULTADOS 
 
En este apartado se presentan los resultados de los procesos desarrollados para obtener 
la cartografía de las cubiertas de suelo de la sub-cuenca hidrográfica del Río Tamulasco, 
de los años 2003 (imagen IKONOS) y 2014 (Imágenes aéreas tomadas en el vuelo LIDAR) 
y el mapa temático del Índice de Vegetación, así como una descripción de cada uno de 
estos mapas temáticos. 
 
Los datos temporales y espaciales se tomaron a partir de las imágenes satelitales, de 
manera que el acceso visual a la información se dio sin dificultades, aunque se trataba de 
imágenes provenientes de fuentes diferentes.  
 
Las variables incorporadas en esta investigación son las que se utilizan para clasificar el 
uso/cobertura de suelo, además de una clasificación que tiene que ver con la clasificación 
de bosques por medio del NDVI que con la de uso/cobertura. 
 
3.1. SENSORES REMOTOS UTILIZADOS PARA USO/COBERTURA DE SUELO Y 

NDVI. 
 
La radiación reflejada, emitida o dispersada, a una determinada longitud de onda, es el 
resultado de interacciones físicas y químicas de la luz incidente con la estructura y 
composición del medio. Por este motivo, una alta resolución espectral mejora las 
posibilidades para la detección de un compuesto. Por otro lado, hasta la fecha, los 
sensores con gran resolución espectral poseen baja resolución espacial. 
 
Sin embargo, respecto a sensores de resolución espacial media se encuentran los que 
poseen los satélites de la NASA LANDSAT ya que permiten el estudio de series 
temporales de hasta cuarenta años con una resolución espacial de 30 metros y temporal 
de dieciséis días; o en esta investigación el caso de satélite comercial de Estados Unidos 
(actualmente no operativo) con una resolución espacial que va a partir de 0.8 a 3.2 metros 
y una resolución temporal de 2.9 a 1.5 días, que para esta investigación los resultados de 
interés se ven prioritariamente en el cambio espacial en su respectiva temporalidad. 
 
3.2. MAPAS TEMÁTICOS 
 
El primer paso, para llevar a cabo la elaboración de mapas de uso/cobertura, recortar las 
imágenes satelitales de manera tal que queden solo los píxeles correspondientes a la zona 
de estudio. Una alternativa consiste en el recorte de la cuenca o del área de interés el cual 
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fue hecha a partir del software QGIS v.2.1819, no sin antes haber trabajado el pre 
procesamiento en ERDAS IMAGINE 2014, como se describe en el ANEXO I. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 3.1: Mapa temático y grafico correspondiente a IKONOS de Clasificación No Supervisada. 

 
Este resultado corresponde a la Clasificación no Supervisada para la imagen IKONOS del 
2003, en el cual se muestra el mapa temático obtenido de uso/cobertura de suelo, este 
mapa nos representa la distribución espacial del uso/cobertura y el grafico nos indica el 
porcentaje de área que cubren cada una de las clases consideradas en esta investigación, 
además, este primer resultado establece nuestra línea base o referencia para evaluar los 
cambios y el posible comportamiento del uso de la cuenca. 
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Figura 3.2: Mapa temático y grafico correspondiente a LIDAR de Clasificación No Supervisada. 
 
 
Este resultado corresponde a la Clasificación no Supervisada para la imagen del vuelo 
LIDAR de 2014 y muestra el mapa temático el cual contiene la distribución espacial del 
uso/cobertura de suelo, para la cual con los datos de la línea base o los datos resultantes 
de la imagen IKONOS de 2003 podemos determinar que la evolución o comportamiento 
de la cuenca en esta clasificación, nos muestra cambios significativos en el uso/cobertura 
de suelo para la categoría Urbano y Agua, relacionándose de manera inversa. 
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Figura 3.3: Mapa temático y grafico correspondiente a IKONOS de Clasificación Supervisada. 

 
Este resultado corresponde a la Clasificación Supervisada para la imagen IKONOS del 
2003, en la cual se muestra el mapa temático obtenido de uso/cobertura de suelo, este nos 
representa la distribución espacial del uso/cobertura y el grafico nos indica el porcentaje 
de área que cubren cada una de las clases consideradas en esta investigación, además, 
este resultado es importante, principalmente debido a que es realizado bajo el criterio del 
reconocimiento en campo de las categorías analizadas, obteniendo de manera más 
confiable el valor de área representada en valores porcentuales que poseen las categorías 
en superficie y la distribución espacial de las mismas, que los resultados obtenidos para 
la Clasificación no Supervisada. 
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Figura 3.4: Mapa temático y grafico correspondiente a LIDAR de Clasificación Supervisada. 
 
 
Este resultado corresponde a la Clasificación Supervisada para la imagen del vuelo 
LIDAR de 2014, este resultado muestra el mapa temático el cual contiene la distribución 
espacial del uso/cobertura de suelo, para la cual con los datos de la línea base o los datos 
resultantes de la imagen IKONOS de 2003 podemos determinar que la evolución o 
comportamiento de la cuenca en cuanto al uso/cobertura en cuanto a esta clasificación, 
nos muestra cambios significativos en el uso/cobertura de suelo para la categoría de 
Agricultura y vegetación arbustiva, relacionándose de manera inversa. 
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Figura 3.5: Mapa temático correspondiente a IKONOS de NDVI. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 3.6: Mapa temático correspondiente a LIDAR de NDVI. 
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Estos resultados corresponden al valor de NDVI para cada una de las imágenes, es decir, 
el NDVI para la imagen IKONOS de 2003 y para la imagen del vuelo LIDAR de 2014, 
estos resultados muestran los valores de NDVI espacio temporal presente en la cuenca.  
 
Los valores de NDVI que se obtienen para las imágenes presentan un cambio muy 
significativo en cuanto a al valor que cada NDVI muestra, esta gran diferencia en los 
datos puede que se deba principalmente a la diferencia de los sensores utilizados para 
obtener la información por lo que el análisis cuantitativo de los resultados no resulte 
confiable, sin embargo, se puede determinar de manera cualitativa el comportamiento de 
la vegetación a partir de esta comparación de NDVI, resultando de manera significativa 
la disminución en la calidad de la vegetación presente en la cuenca y por lo tanto, muestra 
que la evolución de la cuenca en cuanto a los recursos naturales en general se muestra 
desfavorable, por lo que resulta evidente un mejor aprovechamiento de los recursos 
naturales.  
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CONCLUSIONES 

 
Con la realización de esta investigación y la revisión de la bibliografía disponible se 
observó que las investigaciones mediante la técnica de teledetección se encuentran en una 
etapa de marcado crecimiento, además se ha conseguido adquirir conocimientos sobre el 
tratamiento de la información de esta índole, tanto en SIG, Técnicas de Teledetección 
satelital, desarrollo de procesamiento de datos espacio-temporales y la generación de 
mapas temáticos como insumos para futuras investigaciones. Por lo tanto, podemos 
deducir que: 
 
• Se observó que el NDVI presenta una correlación significativa negativa con respecto 

a la imagen del 2003 versus la actual, lo que indica el desmejoramiento de las 
condiciones de la vegetación de la zona, principalmente ya que para la imagen del 
2003 el NDVI es de 0.205 el cual representa un 20.5 % respecto a vegetación sana y 
para la imagen reciente con un valor de 0.0371 que representa el 3.71%, por lo tanto 
podemos decir que se obtiene un resultado desfavorable en cuanto a la calidad de 
vegetación de la zona. 
 

• Fue posible presentar los datos que se observan tanto en el mapa temático como los 
gráficos respectivos, siendo cada una de estas presentaciones de la información 
complementarias entre sí y evidencian la necesidad de que ambos tipos de resultados 
aparezcan siempre para una mejor comprensión del estudio. 
 

• Resulta complicado la comparación del sensor IKONOS con LIDAR por las diferentes 
especificaciones que ambos sensores poseen tanto espaciales, temporales y 
espectrales; principalmente porque en este caso, las imágenes están separadas 
temporalmente tanto en la toma de las imágenes en si como en el análisis temporal 
con las fechas de análisis. 
 

• Sin embargo, podemos observar que en cuanto al análisis del uso cobertura de las 
imágenes para ambas clasificaciones indican un claro cambio en la dinámica de 
uso/cobertura de suelo principalmente afecta o modificada debido a la acción 
antropogénica. 
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• Es importante mencionar que las resoluciones espaciales versus la resolución 
temporal son de alguna manera inversas; ya que, a mayor resolución de píxel, la 
resolución temporal es menor afectando a la periodicidad del paso del sensor. 
 

• Los sensores varían tanto en resolución espacial, temporal, espectral y radiométrica 
por lo que cada uno posee notorias diferencias enfocadas a que es lo que necesitamos 
investigar y así desarrollar los resultados pertinentes en base a nuestros objetivos. 
 

• La utilización de SIG maximiza las posibilidades del aprovechamiento de los datos 
resultantes o derivados de los productos satelitales originales y optimiza los 
resultados en el procesamiento de la información. 
 

• La obtención de este tipo de productos con parámetros biofísicos proveniente de 
estos sensores remotos, permiten el monitoreo espacio-temporal de la vegetación y 
uso/cobertura del suelo. 
 

• Es importante destacar que este tipo de estudios representan una línea base para la 
generación de información y las posibilidades de resolver las problemáticas de 
diversas índoles, sin embargo, es un trabajo holístico y que tiene que ser abordado de 
manera constante, principalmente debido a que lo que se pretende resolver o 
demostrar genera información y resuelve algunas interrogantes, pero genera 
muchísimas otras y que estos estudios deben realizarse en muchos más localidades y 
con un mayor detalle en las investigaciones.  
 

• Las imágenes satelitales de los diversos sensores son una herramienta con mucho 
valor e importancia para las investigaciones que se quieren realizar, es necesario 
determinar nuestros objetivos de estudio para adquirir los productos de los sensores 
disponibles para adecuarnos mejor a la información resultante que obtendremos. 
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RECOMENDACIONES 
 

• Es necesario que este tipo de investigaciones espaciotemporales se realicen con los 
insumos necesarios y correspondientes, es decir, que los sensores atreves de la 
escala temporal sean obtenidos por una sola plataforma o sensor, ya que eso 
mantiene los parámetros en todo el desarrollo del análisis de los datos. 
 

• Tomar en cuenta tiempo adecuado para la adquisición de los productos o insumos 
en cuanto a las imágenes satelitales se refiere, ya que, para cada tipo de producto 
o tipo de investigación, la época y la estación del año en que se obtenga las 
fotografías es de mucha importancia para evitar  obtener errores o valores no 
deseados antes de realizar el procesamiento de la información (pre procesamiento). 
 

• Finalmente, la fase de campo para este tipo de estudios resulta muchas veces como 
una herramienta auxiliar para confirmar los resultados, no debe de prescindir de 
esta, principalmente debido a que conocer mejor la zona de estudio brinda 
confiabilidad en los resultados obtenidos. 
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ANEXOS 

 
ANEXO I - PRE PROCESAMIENTO DE IMÁGENES 
 

- Convertir de geotiff (.tif) a .img - 
 

1. Importamos la imagen en Manage data > import data 
 
 
 

 
2. Con lo que se desplegará la siguiente ventana 

 
 
 
 
 
 
 

3. Format > GeoTIFF; Input File > po_188172_0010000.tif ‘buscamos la carpeta donde esta 
nuestra imagen y seleccionamos la correspondiente a una banda de la imagen’; Output 
File > po_188172_0010000.img ‘guardamos esta imagen .img correspondiente a una 
banda de la imagen’; OK ‘luego seleccionamos OK’. 
 
 
 
 
 
 
 

4. Con lo que desplegara la siguiente ventana 
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5. Y seleccionamos OK nuevamente y se desplegara la siguiente ventana informando que 
el proceso se realizó de manera satisfactoria, con lo que ya están convertidas a .img 
desde Geo TIFF. 
 
 
 
 
 
 
 
 
 
 

6. Lego se repite el proceso para cada una de las demás bandas, en este caso se realizó 
para las 5 bandas en total, en los archivos de la imagen Ikonos po_188172_0010000, 
po_188172_0020000 y po_188172_0030000, debido a que dentro de estos sectores se 
encuentra la zona de estudio (área de la cuenca). 
 
 
 
 
 
 
 
 
 

7. Es importante mencionar que una vez establecida la carpeta de salida (Output File) 
ERDAS mantiene esta dirección para cada salida sin que tengamos que modificar esta 
instrucción, por lo que solamente es necesario el archivo de entrada (Input file) que 
como mencionaba en nuestro caso se realizó para las 5 bandas que posee la imagen. 
El siguiente proceso es combinar las bandas que se han convertido a .img, para lo cual 
seleccionamos Raster > Spectral > Layer Stack. 
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8. ‘Agregamos cada archivo .img correspondiente a cada banda espectral una a una, sin 
agregar la banda espectral correspondiente a la pancromática, debido a que esta se 
utilizará luego en el mejoramiento de resolución espacial de la imagen final a trabajar’ 
> Add > ‘Elejimos la carpeta de salida con un nombre apropiado para la nueva imagen, 
en este caso se llamó 10krgbn’ > OK. 
 
 
 
 
 
 
 
 
 

9. Podemos comprobar la combinación de bandas abriendo dicho archivo .img 
(10_stacked.img). Open (ctr+o) ‘seleccionamos la carpeta donde está contenido nuestro 
archivo’ > OK 
 
 
 
 
 
 
 
 

10. Home > Fit to Frame ‘para ajustar la capa al tamaño de la ventana’ 
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11. Una vez realizada para cada una de las imágenes y para las bandas Red, Green, Blue 
y NIR se obtiene la siguiente imagen, la cual esta visualizada en color real (RGB). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

12. Por lo tanto, se realizará con estos tres archivos el procesamiento de la imagen. En 
primer lugar, se realizará el mejoramiento espacial, para lo cual se realiza lo siguiente: 
Se abre la imagen multi-espectral que se desea mejorar, para nuestro caso las que 
contiene el área de la cuenca. 
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13. Luego se abre en otra vista la imagen pancromática correspondiente, como se muestra 
a continuación. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

14. Podemos ver que en la imagen multi-espectral posee un tamaño de pixel de 4m. 
Mientras que la imagen pancromática posee un tamaño de pixel de 1m, como se 
muestra a continuación. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

15. Para iniciar el mejoramiento en la resolución espacial nos vamos al menú Raster > Pan 
Sharpen > Resolution Merge. 
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16. Se establecen los siguientes parámetros, en High Resolution Input File > 
‘seleccionamos l imagen pancromática correspondiente’, en Multispectral Input File > 
‘seleccionamos la imagen multiespectral correspondiente’, Output File > ‘nombramos 
el archivo de salida con el mejoramiento espacial (el archivo resultante es 
extensión .img ya que es el formato nativo con que ERDAS trabaja, sin embargo se 
puede cambiar el tipo de formato según sea el caso), Method > Principal Component 
(debido a que realza zonas que han sufrido cambios asociados a cobertura con mayor 
detalle en cambios de cobertura vegetal), Resampling Technique > Nearest Neighbor 
(debido a que este ajuste no cambia los valores de DNs (Spectral Radiance) de la 
imagen satelital), Output Options > Ignore Zero in Stats, Data Type > Output > Signed 
16 bit, finalmente OK. 
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17. Terminado el proceso de manera satisfactoria comprobamos el resultado abriendo la 
imagen en una tercera vista (derecha inferior). De manera que se verifica el 
mejoramiento espacial de la imagen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

18. Para confirmar formalmente el mejoramiento espacial revisamos la ventana que 
muestra los metadatos y verificamos que de la resolución original de 4m pasa a una 
resolución de 1m. 
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19. De igual manera procedemos a realizar el mejoramiento espacial de la imagen 
po_188172_0020000 y po_188172_0030000, que son las otras partes de la imagen que 
contiene a la cuenca de interés. Y verificamos nuevamente el resultado de las nuevas 
imágenes y también con la información de los metadatos respectivamente como se 
muestra a continuación. 
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20. Para nuestra siguiente etapa, realizaremos la unión o mosaico de las imágenes que 
necesitamos, para ello cargamos las imágenes a utilizar, es decir la imagen 
po_188172_0010000, po_188172_0020000 y po_188172_0030000 con todos los pasos 
anteriores. 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

21. Para ello selecionamos la opción Raster > Mosaic > MosaicPro. 
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22. Lo que abrirá la siguiente ventana. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

23. Comenzamos cargando las imágenes a trabajar, seleccionamos la opción Display Add 
Images Dialog. 
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24. Y cargamos las imágenes 10kmerge, 20kmerge y 30kmerge que son las imágenes con 
resolución espacial mejorada de los archivos originalmente po_188172_0010000, 
po_188172_0020000 y po_188172_0030000 correspondientemente. Y para visualizar las 
imágenes a trabajar en la parte inferior aparecen los nombres de los archivos que 
utilizaremos para realizar el mosaico (unión) y en la celda de Visualización (Vis.) las 
activamos para poder ver nuestras imágenes a trabajar. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

25. Luego seleccionamos la opción Seamline Generation Options > Geometry-based 
Seamline >OK 
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26. Con lo que aparecerá la siguiente modificación en la ventana de trabajo. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

27. Vemos que la imagen a trabajar muestra un vacío en la parte media, para solucionar 
este problema recurrimos a la herramienta Edit seams polygon, con el que crearemos 
un área sobre el vacío en la imagen para que aparezca completamente. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

 

77 
 

28. Seguimos con Images Resample Options > Method > Nearest Neighbor > Apply. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

29. Verificamos que en la opción de Color Corrections no se encuentre ninguna casilla 
marcada. 
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30. De igual manera para la opción Set Seamline Function > No Smooting > No Feathering. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
31. Finalmente guardamos el nuevo archivo de salida en la opción Run The Mosaic 

Process To Disk y le damos un nombre de salida a nuestra nueva imagen y la carpeta 
de salida y seleccionamos OK. 
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32. Cargamos la imagen para verificar el resultado. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

33. Vemos que el proceso termino de manera satisfactoria. Ahora procederemos con el 
corte de la sección que nos interesa, es decir, el área de la cuenca a trabajar. Para ello 
se realizará la re-proyección de la imagen, ya que la proyección con la que se trabajará 
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será la UTM WGS84 North 16 y la imagen posee la siguiente proyección que se 
encuentra dentro de sus metadatos como se muestra a continuación. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

34. Por lo tanto, para iniciar la re-proyección seleccionamos Raster > Reproyect images 
 
 
 
 

35. Con lo que se ha de desplegar la siguiente ventana 
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36. Se establece el archivo de entrada, salida y la proyección que a la que se desea 
transformar, en Categories y Proyection. Luego seleccionamos OK. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

37. Realizada la reproyección, verificamos los resultados con los metadatos modificados, 
como se muestra a continuación. 
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38. De igual manera realizamos la reproyección para la imagen más reciente y 
nuevamente verificamos los resultados como se muestra a continuación. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

39. Realizada la reproyección en ambas imágenes, continuamos con el corte del área de la 
cuenca a trabajar en la imagen antigua, para este procedimiento se realizará un corte 
con un polígono irregular con un vector, el cual será el límite de la cuenca a trabajar, 
para lo que debemos cargar nuestra vector con extensión .shp. 
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40. El cual tiene la misma proyección de la imagen que vamos a trabajar. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

41. Ahora en el menú Home > Select ‘y damos click sobre el vector el cual servirá para 
realizar el corte’, luego Home > Edit > Paste From Select Object. 
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42. Automáticamente aparecerá una nueva capa Aoi, la cual la guardamos en una carpeta 
y nombre definido y desmarcamos el vectror de la cuenca .shp. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

43. Procedemos a realizar el recorte, por lo que seleccionamos el menú Raster > Subset & 
Chip > Create Subset Image. 
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44. Con lo que se desplegara la siguiente ventana de menú y seleccionamos el nombre de 
salida correspondiente al corte de la cuenca, Ignore Zero in Output Stats, AOI > AOI 
File ‘buscamos el archivo .aoi (area of interest) que se creó y guardó para este 
procedimiento’ y finalmente OK en AOI y OK en Subset. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

45. Procedemos a cargar el corte de la imagen satelital para verificar el resultado obtenido. 
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46. Ahora realizaremos las correcciones radiométricas, para eso nos vamos al menú Raster 
> Radiometric > Haze Resolution, como se muestra acontinuación. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

47. Seleccionamos esta herramienta y aparecerá la siguiente ventana de trabajo, 
establecemos el archivo de salida y seleccionamos OK. 
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48. Finalmente, abrimos la nueva imagen una nueva vista para comprobar los resultados. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

49. De igual manera realizamos el mismo proceso para la siguiente imagen y verificamos 
los resultados. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

50. Con esto finalmente tenemos la corrección radiométrica para ambas imágenes.  
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ANEXO II - PROCESAMIENTO DE IMÁGENES 
 
Clasificación No Supervisada 
1. Iniciaremos con la clasificación no supervisada, para esto nos dirigimos al menú Raster 

> Unsupervised > Unsupervised Clasification y se despliega una ventana de trabajo 
como se muestra a continuación. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Se despliega la siguiente ventana de trabajo  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. En esta ventana de trabajo solamente se define el archivo de salida y la aproximación 

al verdadero color en Color Scheme Options > Aproximate True Color, y finalmente se 
inicia la clasificación en OK. Es importante mencionar que, por defecto en este caso, la 
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clasificación no supervisada establece un número de clases de 36 y de iteraciones 10, 
que se debe a la gran área de trabajo, por lo que realizaremos esta clasificación por 
defecto y luego la haremos nuevamente con las clases que suponen un interés más 
simplificado para nuestro caso. El resultado por defecto se muestra a continuación, con 
su respectiva tabla de atributos ubicada al lado izquierdo de la imagen. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
4. Este es el resultado que se obtiene por defecto, debido al área de trabajo. Este resultado 

es demasiado especifico, por lo que se realizará nuevamente esta clasificación para 6 
grupos de clases que nos interesan los cuales son: agua/humedad, bosque primario, 
bosque secundario, vegetación arbustiva, pasto/cultivo y zona urbanas/suelo desnudo; 
para ello se especifica el número de clases y el número de iteraciones se mantiene (el 
máximo de iteraciones recomendadas es un máximo de 11).  
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5. Una vez realizado el proceso, abrimos la nueva imagen para verificar los resultados. 
Este mapa es el primer mapa temático de la Cuenca del Tamulasco. Esta muestra los 
tipos de clases con nombre y correspondiente color en la tabla de atributos que se ubica 
en la parte izquierda de la imagen resultante. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. Realizamos el proceso para la siguiente imagen más actual del área de trabajo, para 
realizar el proceso nuevamente, de manera automática, dejando los parámetros como 
el software recomienda y luego con los cambios que se realizaron anteriormente.  
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7. Una vez realizado este proceso, abrimos la imagen resultante para verificar los 
resultados. La imagen resultante se verifica con su respectiva tabla de atributos del 
lado izquierda de la misma. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
8. Luego realizamos nuevamente la clasificación no supervisada y modificamos el 

número de clases como anteriormente se mostró. 
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9. Una vez realizado este proceso, abrimos la imagen resultante para verificar los 
resultados. La imagen resultante se verifica con su respectiva tabla de atributos del 
lado izquierda de la misma. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

10. Con esto finalizamos la clasificación no supervisada para ambas imágenes, ahora 
seguiremos con la clasificación supervisada, para ello vamos al menú  
Raster > Supervised > Signature Editor, como se muestra a continuación. 
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11. Se desplegará la siguiente ventana que se muestra y para comenzar a generar nuestros 
AOI, seleccionamos en el menú Drawing > Polygon y creamos un polígono con la 
muestra que queremos clasificar, para este caso lo realizaremos como ejemplo inicial 
una muestra de bosque primario en la zona alta de la cuenca y lo agregamos a la 
ventana Signature Editor con la opción Create New Signature(s) from AOI, como se 
muestra a continuación. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

12. Una vez seleccionados y agregados las firmas de clases, en este caso se seleccionaron 
15 firmas como se muestra a continuación. 
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13. Y la ubicación espacial de las mismas, se muestra a continuación. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

14. Ahora iniciamos la clasificación supervisada en el menú Classify > Supervised, como 
se muestra a continuación. 
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15. El cual desplegará el siguiente menú, en el cual seleccionamos el destino y nombramos 
el archivo de salida en Output File y Parametric Rule > Minimum Distance y 
finalmente OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
16. Abrimos la nueva imagen para revisar los resultados, como se muestra a continuación. 
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17. Y un resultad más afinado, una vez mejorada la paleta de colores para facilitar la 
interpretación temática cartográfica, como se muestra a continuación. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

18. Y realizamos el proceso nuevamente con la imagen más reciente. Una vez 
seleccionados y agregados las firmas de clases, como en el caso anterior se 
seleccionaron 12 firmas como se muestra a continuación. 
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19. Y verificamos los resultados de la clasificación como se muestra a continuación. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

20. Con esto concluimos el trabjo en Erdas Imagine 2014 y procedemos a realizar ambas 
clasificaciones para ambas imágenes en Qgis 2.1819. 
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Clasificación NDVI 
 
1. Realizaremos el proceso conocido como NDVI (Normalized Diference Vegetation 

Index), para esto abrimos la imagen a trabajar; luego nos dirigimos al menú Raster > 
Unsupervised > NDVI, como se muestra a continuación. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Con lo que se desplegará la ventana de trabajo. 
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3. Se selecciona Sensor > IKONOS Multispectral y el nombre de salida de la imagen 
resultante, finalmente > OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Verificamos los resultados como se muestra a continuación. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Con esto terminamos el procedimiento del NDVI para la imagen antigua. 
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6. De igual manera realizamos el proceso para la imagen más reciente y verificamos los 
resultados como se muestran a continuación. 
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ANEXO III – MAPAS DE LA ZONA DE ESTUDIO DISPONIBLES 
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ANEXO VI – RECONOCIMIENTO DE CAMPO DE LA ZONA DE 
ESTUDIO 
 
En este apartado se muestran algunas fotografías tomadas durante la visita al sitio de 
estudio. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fotografía del Bosque de Coníferas de la parte alta de la cuenca del Río Tamulasco 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fotografía de un nacimiento de un afluente de la parte alta de la cuenca del Río 
Tamulasco. 
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Fotografía de una planicie de uso pecuario de la parte alta de la cuenca del Río Tamulasco. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fotografía de zona urbana de la parte alta de la cuenca del Río Tamulasco; nótese que no 
se cuenta con un manejo de los desechos de las comunidades. 
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Fotografía de una planicie de uso pecuario de la parte alta de la cuenca del Río Tamulasco. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fotografía de bosque montañoso de la parte alta-media de la cuenca del Río Tamulasco. 
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Fotografía de zona urbana de la parte alta-media de la cuenca del Río Tamulasco. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fotografía de zona urbana de la parte alta-media de la cuenca del Río Tamulasco. 
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Fotografía de zona urbana de la parte media de la cuenca del Río Tamulasco. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fotografía del cauce del río Tamulasco cercano a zona urbana de la parte media. 
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Fotografía de letreo de proyecto de la parte media de la cuenca del Río Tamulasco, 
cercano a la Ciudad de Chalatenango.  
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